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Introduction

About GFI ReportCenter

%
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Figure 1 - Centralized reporting framework

GFI ReportCenter is a centralized reporting framework that allows you
to generate various reports using data collected by different GFlI
products. GFI releases specialized reports for each of its products,
referred to as a ReportPack; for example, the GFI LANguard Network
Security Scanner ReportPack. A ReportPack can be purchased as an
add-on to the GFI product.
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Figure 2 — Several ReportPacks plugged into the GFI ReportCenter framework

A ReportPack plugs into the GFI ReportCenter framework; allowing
you to generate, analyze, export and print the information generated
through these reports.

About the GFI LANguard N.S.S. 8.0 ReportPack

The GFI LANguard Network Security Scanner ReportPack is a full-
fledged reporting companion to GFI LANguard Network Security
Scanner (GFI LANguard N.S.S.). It allows you to generate graphical
IT-level, technical and management reports based on the network
security audits carried out by GFI LANguard N.S.S.

From trend reports for management (ROI) to daily drill-down reports
for technical staff; the GFI LANguard N.S.S. ReportPack provides you
with the easy-to-view information required, to fully identify any
vulnerability on your corporate network.

The GFI LANguard N.S.S. ReportPack allows for the creation of
various graphical and text based reports related to:

e Vulnerabilities scanning reports
e Patch management reports

e System information reports

e Results comparison reports.

Components of the GFI LANguard N.S.S. 8.0 ReportPack

When you install the GFI LANguard N.S.S. 8.0 ReportPack, the
following components are installed:

e GFI ReportCenter framework
e GFI LANguard N.S.S. 8.0 default reports

GFI ReportCenter Introduction e 7



Report scheduling service.

GFI ReportCenter framework

The GFI ReportCenter framework is the management console through
which you can generate the specialized product reports which are
shipped with a product ReportPack. The GFI ReportCenter framework
offers a common application interface through which you can
navigate, generate, customize and schedule reports.
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Screenshot 1 — The GFI ReportCenter management console

The GFI ReportCenter management console is organized as follows:

Navigation Pane — Use this pane to access the navigation
buttons/configuration options provided with GFI ReportCenter.

Product Selection drop-down list — Use this drop-down list to
select the GFI product for which to generate reports. The Product
Selection drop-down list displays all the products for which you
have installed a ReportPack.

Favorite Reports — Use this navigation button to access your
favorite/most used reports. For more information on how to add
reports to this list refer to the ‘Adding default reports to the list of
favorite reports’ and ‘Adding custom reports to the list of favorite
reports’ sections in this manual.

Default Reports — Use this navigation button to access the
default list of reports which can be generated for the selected
product. For more information on default reports refer to the ‘GFI
LANguard N.S.S. default reports’ section in this manual.

Custom Reports — Use this navigation button to access the list

8 e Introduction
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of customized reports which can be generated for the selected
product. For more information on how to create custom reports
refer to the ‘Custom reports’ chapter in this manual.

Scheduled Reports — Use this navigation button to access the
list of scheduled reports for automatic generation and
o distribution. For more information on how to create scheduled
reports refer to the ‘Scheduling reports’ chapter in this manual.

Options — Use this navigation button to access the general
@ | configuration settings for the GFI product selected in the
Product Selection drop down list.

Help — Use this navigation button to show this Quick Reference
© | Guide in the Report Pane of the GFI ReportCenter management
console.

Report Pane - Use this multi-functional pane to:

« View and analyze generated reports

e Maintain the scheduled reports list

« Explore samples and descriptions of default reports.

Export — Use this button to export generated reports to various
@ | formats including HTML, Adobe Acrobat (PDF), Excel (XLS),
Word (DOC), and Rich Text Format (RTF).

Send email — Use this button to instantly distribute the last
generated report via email.

GFI ReportCenter Introduction e 9



GFI LANguard N.S.S. 8.0 default reports

The GFI LANguard N.S.S. 8.0 default reports are a collection of
specialized pre-configured reports which plug into the GFlI
ReportCenter framework. These reports present the results of network
security scans performed by GFI LANguard N.S.S. and allow for the
generation of both graphical and tabular IT-Level, technical and
management reports. Default reports can also serve as the base
template for the creation of customized reports which fit specific
network-reporting requirements.

Report scheduling service

The report scheduling service controls the scheduling and automatic
distribution of reports by email. Reports generated by this service can
also be saved to a specific hard disk location in a variety of formats
which include DOC, PDF, RTF and HTML.

Key features

Centralized reporting

GFl ReportCenter is a one-stop, centralized reporting framework
which enables the generation and customization of graphical and
tabular reports for a wide array of GFI products.

Wizard assisted configuration

Wizards are provided to assist you in the configuration, scheduling
and customization of reports.

Report scheduling

With GFI ReportCenter you can schedule reports to be generated on a
pre-defined schedule as well as at specified intervals. For example,
you can schedule lengthy reports to be generated after office hours.
This allows you to maximize the availability of your system resources
during working hours and avoid any possible disruptions to workflow.

Distribution of reports via email

GFI ReportCenter allows you to automatically distribute generated
reports via email. In scheduled reports, this can be achieved
automatically after the successful generation of a scheduled report.

Report export to various formats

By default, GFI ReportCenter allows you to export reports to various
formats. Supported formats include HTML, PDF, XLS, DOC and RTF.
When scheduling reports, you can optionally configure the preferred
report output format. Different scheduled reports can also be
configured to output generated reports to different file formats.

Default reports

The GFI LANguard N.S.S. ReportPack ships with a default set of
graphical and tabular reports. These reports can be generated without
any further configuration effort immediately after the installation. The
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default reports in this ReportPack are organized into four different
report-type categories:

¢ Vulnerabilities scanning reports
e Patch management reports

e System information reports

e Results comparison reports.

Report customization

The default reports that ship with every ReportPack can serve as the
base template for the creation of customized reports. Report
customization is achieved by building up custom data filters which will
analyze the data source and filter the information that matches
specific criteria. In this way, you create reports tailored to your
reporting requirements.

Favorites

GFl ReportCenter allows you to create bookmarks to your most
frequently used reports — both default and custom.

Printing

By default, all reports generated by GFI ReportCenter are printer
friendly and can be printed through the windows printing services
provided by the system where GFI ReportCenter is installed.

License scheme and evaluation period

Evaluation period

The default evaluation period for this product is of 10 days. However
you can apply for a 30-day product evaluation key by filling in our
online registration form. This will also qualify you for free email
support. The 30-day evaluation period key will be emailed to you
automatically after you download the product.

NOTE: During the evaluation period, you may use all the features
available with GFI ReportCenter.

Purchasing a license key

You can purchase a license key online by visiting the GFI website
(https://www.gfi.com/pages/cart/orderform.aspx). After purchasing a
product license, you do not need to re-install the GFI ReportCenter
framework and GFI LANguard N.S.S. ReportPack. Just key in the
license key via the Licensing node provided in the management
console. For more information refer to the ‘Entering your license key
after installation’ section in this manual.
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Installation

System requirements

Install the GFI LANguard N.S.S. ReportPack on a computer that
meets the following requirements:

¢ Windows 2000 (SP4) / XP (SP2) / 2003 operating system

e Internet Explorer 5.1 or higher

e _.NET Framework version 1.1.

NOTE: The GFI LANguard N.S.S. ReportPack only allows you to
generate reports for data contained in scan results databases which
were created and maintained by GFI LANguard N.S.S.

Installation procedure

The GFI LANguard N.S.S. ReportPack includes an installation wizard
which will assist you through the installation process. During the
installation process this wizard will:

o Verify that you are running the latest version of the GFlI
ReportCenter framework; if you are installing the framework for the
first time or the currently installed framework version is outdated,
the installation wizard will automatically download the latest one
for you.

e Automatically install all the required components distributed
including the GFI ReportCenter framework, the GFI LANguard
N.S.S. default reports and the Report Scheduling service.

To start the installation:

1. Double-click on languardnss7rp.exe. As soon as the welcome
dialog is displayed, click Next to start the installation.
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]'E GFI Hetwork Security Scanner 8 ReportPack Setup M= E3

GFI Report Center Framework de._.

GFI Report Center framework. was not found on the spstem

GFl Metwork, Securnty Scanner 8 BeportPack requires GFl Report Center frameworks verzion
3.5 in arder to run. *rou need to download and install the GFI Repart Center framewark,
verzion 3.5 in order bo proceed.

* Download and install the GFl Bepart Center framewark. version 3.5,
| will arwsally install GFl Beport Center framework version 3.5 and restart this installation.

Cancel

< Back

Screenshot 2 - GFI ReportCenter framework detection dialog

2. If the current version of your GFI ReportCenter framework is not
compatible with the GFI LANguard N.S.S. ReportPack, you will be
prompted to download and install an updated version. To
automatically achieve this, leave the dialog options as default and
click on the Next button.

]'E GFI Metwork Security Scanner 8§ ReportPack Setup [ [ ]

Check for latest build availability

Check for a newer verzion of GFl Mebtwork Security Scanner 8 ReportPack.

Thiz inztallation can check whether there iz a newer build for GF1 Mebwork Security
Scanner B ReportPack downloadable from the GF] web site. Thiz procedure wil
require an intermet connection in order to connect ta the GFl web site.

% “Yes, please check for a newer version of G M.5.5. 8 ReportPack on the GFl web site.
(" Mo thark wouw, do not check for a newer version and continue with the curent installation,

Cancel

Screenshot 3 - Check for latest build availability

3. Choose whether you want the installation wizard to search for a
newer build of the GFI LANguard N.S.S. 8.0 ReportPack on the GFlI
website. Then, click on the Next button to proceed with the
installation.

GFI ReportCenter Installation e 13



4. In the license dialog, read the licensing agreement carefully. Select
the ‘I accept the Licensing agreement’ option and click on Next to
continue.

]'E GFI Metwork Security Scanner 8§ ReportPack Setup [ [ ]

Licenze Key

Enter the following information to perzonalize your installation

Please enter pour name, company and licenze key. If pou do not have a license kep pou can
uze GFI Metwork Securnity Scanner 8 ReportPack as an evaluation werzion for the firzt 10

dapsz.
Full Mame: [ahn Dol
Cormpary: |GFI Software Ltd
Licenze ke |Evaluatiu:un

¢ Back Memwt » | Cancel

Screenshot 4 - Licensing details dialog

5. Specify the full user name, the company name and the license key.
If you will be evaluating the product for 10 days, leave the evaluation
key as default (i.e. “Evaluation”). Click on Next to continue.

]ﬁ GFI Network Security Scanner 8 ReportPack Setup [_ [ x|

Databasze Selection

Select the database to be uzed by GFl Metwork, Security Scanner 8
FReportPack.

Pleaze zelect the databaze to be uzed by the GFI Metwark Secunity Scanner 8 ReportPack.

(¥ i |ze the test database provided i installation for evaluation purposes

" Use a LaMNguard Metwark Security Scanner 8 Access database
" ze a L&Mguard Metwaork Security Scanner 8 M5 SEL Server/MSDE databaze

< Back Memt » | Cancel

Screenshot 5 — SQL Server selection dialog

6. Specify which database backend is being used by your GFI
LANguard N.S.S. installation.

14 e Installation
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NOTE 1. For evaluation purposes you can also use the sample
database that is distributed with this installation.

NOTE 2: If a MS Access database is being used and you are not
installing the GFI LANguard N.S.S. ReportPack on the same computer
that is running GFI LANguard N.S.S., click Browse and specify the
path to your MS Access database backend using UNC (e.g. \LNSS
Server\GFI\ScanResults.mdb).

]'E GFI Hetwork Security Scanner 8 ReportPack Setup M= E3

SAL Server selection

Fleaze enter the requested information

Please specify an SEL server containing a vald LaMNguard Hetwork. Securnity Scanner 8
databaze, and the necessary logon infarmation.

SOL server details:

Server: SOLSERYER SOLSERYER

[ Uszse Windows authentication.

Lagin uzing the following credentialz [SOL Account]:

zer |$a

HHREERRRHN

Pazzword:

Cancel

Screenshot 6 - Database configuration dialog

7. If an MS SQL Server/MSDE database backend is being used,
specify the SQL server details (name, authentication method and
credentials). Click on Next to continue.

]'E GFI Network Security Scanner 8§ ReportPack Setup M= E3

Mail Settings

Enter administrator email and SMTP mail server settings

Fleaze enter the detailz of the SMTF server and emall adress that are to be used by GFI
Metwork. Security Scanner B ReportPack for email reporting.

Eror: |I3FIF|epDrtEenter@1 27.0.0.1

SMTP zerver |'| 27.001 Part: |25

* SMTP server does not require authentication.

To: |administratur@lucalhcust

" SMTP server requines authentication,

Werify Mail Settings |

< Back Cancel |
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Screenshot 7 - Email configuration dialog

8. Specify the default email settings that will be used for report
distribution.

9. Specify the product installation path or click Next to leave as
default. The installation will need approximately 100 MB of free disk
space.

10. The installation wizard is now ready to copy the required files and
finalize the installation. To proceed click on the Next button.

Launching the GFI LANguard N.S.S. reports for GFl ReportCenter

Following the installation, launch the GFI LANguard N.S.S. Reports for
GFl ReportCenter from Start » Programs » GFl ReportCenter »
LANguard Network Security Scanner 8 ReportPack.

NOTE: GFI ReportCenter will run with limited functionality upon expiry
of the evaluation period. This will also occur if the license key you
entered is not a valid GFI ReportCenter license key.

Selecting a product

When more than one product ReportPack is installed, use the
Product Selection drop down list to select the GFI product
ReportPack to be used.

Product Selection

IGFI L.-‘-‘-.Nguard M ebwark, Seu:urlt_u Scanner B EI HepurtP‘aclJ

el ERoDhCTS

Screenshot 8 — Product Selection drop down list

For example, to run the reports provided in the GFI LANguard N.S.S.
ReportPack:

1. Launch GFI ReportCenter from Start » Program Files » GFlI
ReportCenter.

2. Select ‘GFI LANguard Network Security Scanner 8.0° from the
Product Selection drop down list.

NOTE: Select the ‘ALL PRODUCTS’ option to display and navigate all the
ReportPacks that are currently installed in GFI ReportCenter.

16 e Installation GFI ReportCenter



Getting started: Default reports

Introduction

After installing the GFI LANguard N.S.S. ReportPack, a number of
specialized pre-configured reports can immediately be generated on
the data stored in the database backend of GFI LANguard N.S.S.
These default reports are organized into the following categories:

¢ Vulnerabilities scanning reports: Use the reports in this
category to identify vulnerabilities detected on the network. The
reports include vulnerability details such as host machines,
operating systems affected and severity.

e Patch management reports: Use the reports in this category to
display information on network patches and service packs installed
as well as those still requiring deployment.

e System information reports: Use the reports in this category to
display detailed information on hardware and software present on
the network. These reports help management in analyzing
conformance with corporate security policy.

e Results comparison reports: Use the reports in this category to
compare results of consecutive network scans that have a
common profile and target, and of computer scans against a
computer used as benchmark.

GFI LANguard N.S.S. default reports are accessed by clicking on the
Default Reports navigation button provided in the navigation pane.

Generating a default report

To generate a default report:

1. Click on the Default Reports navigation button to bring up the list
of default reports available.

GFI ReportCenter
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Default Reports

= [l GFI LAMguard Mebwork Security Scanner 8.0 ReportPack
B “ulnerahbilitie:s Scanning
M etwork, Vulnerability Surnmary

----- E. Metwork, Yolnerabiity Trend For Last Scan
----- _5-: Wulnerability distribution by Hosll Add To Fasvaonites List For Last 7 Days
----- w| Yulnerability distribution by Ope For Last 30 Days
..... = . . M ew ]

@ Securty Scans History For Custom D ate

----- g. Yulnerability izting by Cateqary
----- ﬁ Wulnerability listing by Host

----- g Wulnerability izting by Product
----- g Wulnerability lizting by Severity
----- g. Open Trojan Ports by Host

----- g. Top SAMNS Yulnerabilities Status

----- | Wulnerable Hosts based on Open Parts

----- = Open Trojan Ports

-5+ Patch Management
B4+ System Infarmation
B4+ Results Comparizon

Screenshot 9 — Selecting the data set

2. Right-click on the report to be generated, select Run and specify
the scan date/time period that will be covered by the report.

Example 1: Generating a “Network Vulnerability Summary”
report based on the last scan.

This example demonstrates how to generate a network vulnerability
summary report based on the last network security scan carried out:

1. Click on the Default Reports navigation button to bring up the list
of available reports.

2. Right-click on Network Vulnerability Summary and select Run »
For Last Scan.

Example 2: Generating a “Network Vulnerability Summary”
report based on scans made on a particular day.

This example demonstrates how to generate a network vulnerability
summary report based on the scan performed on January 14, 2007.

1. Click on the Default Reports navigation button to bring up the list
of available reports.

2. Right-click on Network Vulnerability Summary and select Run P For
Custom Date.

18 e Getting started: Default reports
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Specify Custom Date

Date Time
Select the datetime period on which to base the report

Reports bazed on date and time will gather all scanz made during the selected time period and
will generate rezults bazed on information found durind these scans.

" Relative

ITDda_I,I j
& Day

| Sunday . January 14, 2007 LI

. n January, 2007 n
Sun Mon TueWed Thu Fri Sat 7| fear |2DD?

A0 1 2 3 4 5 €
78 9 10 1 12 13 —
B s 16 17 18 19 zofl0EM =
222 23 M 2B B T [n =

l2a[29]20 =1 1 2 3
S 4 5 B 7 8 9 10

[ |Today: 1/29/2007 Dok [ Mews | Cancel

Screenshot 10 - Configuring custom date/time period

3. Select the ‘Day’ option and expand the provided drop down. This
will bring up the date selection calendar.

4. Navigate to the required month (i.e. January) and select the
required day (i.e. 14).

5. Click Finish to generate the report.

Example 3: Generating a “Network Vulnerability Summary”
report based on data collected over a specific date/time
period.

This example demonstrates how to generate a network vulnerability

summary report based on network security scans carried out between
January 14, 2007 and January 22, 2007.

1. Click on the Default Reports navigation button to bring up the list
of available reports.

2. Right-click on Network Vulnerability Summary and select Run »
For Custom Date.

GFI ReportCenter Getting started: Default reports e 19



Specify Custom Date

Date Time Lo,
Select the datetime period on which to base the report

Reports bazed on date and time will gather all scanz made during the selected time period and
will generate rezults bazed on information found durind these scans.

" Relative

ITDda_I,I j
= Day

| Monday . January 23, 2007 LI
' Manth

IJanuar_l,l | e |2EIEI?

* Date range
Eromi | 114/2007 =] ooo00aM ==
Too | 17222007 =||235359PW ==

< Back |

Screenshot 11 - Configuring custom date/time period

Cancel |

3. Select the ‘Date range’ option and specify the required parameters:
e ‘From’ —01/14/2007 0:00:00.
e ‘To'—01/22/2007 23:59:59.

NOTE: Date and time format are based on the regional settings
configured on your computer.

4. Click Finish to generate the report.

Analyzing the generated report

GFI ReportCenter 3.5 H[=] E3
File Took Help

I IAFTEFT Y .
Ko« » W B X 7= @

MainReport |
[ GFI LN guard Network Secuity Scanver 8.0 ReportPack 7] =

Product Selection

Default Reports Scanreference:  127.0.0.1
Scan date & time:  20-Jan-2007 16:20

[l [@l] GFI LANguard Network Security Scanner 8.0 ReportPack |
1117 Vulnerabiltes Scanning

=] Netwark Vulnerabilty Trend
| Vulnerability distribution by Host

| Vulnerability distribution by Operating System
% Secuity Scans Histary

& Vulnerabily listing by Category

@ Vulnerabilty listing by Host

@ Vulnerabilty listing by Product

@ Vulnerabilty listing by Severity

@ Dpen Trojan Ports by Host

& Top SANS Yulerabilties Status

=] Wulherable Hosts based on Open Ports

2| Open Trojan Parts

147 Patch Management

2] Network Patching Status

& Missing Patches Grouped By Host

& Missing Patches Grouped By Dperating System
@ Missing Patches Grouped By Geverity

@ Installed Patches Grouped By Host

- 4@ Installed Patches Grouped By Dperating System

10218810075 MARK 5 1 3

G Lottt Db b e et B1s € e

Bl | R

¢ Favorite Reports . B izchun

i Default Reports

) Custom Reports
|5 scheduledReports

Whdon 5 %P

£ options

) Help Windows XP 2 5 1 & =

[Current Page Ma.: 2 [Total Page Mo.: 8 |2aam Factor: 75%
[ 7

Screenshot 12 — Generated reports are displayed in the right pane of the management console
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Generated reports are shown in the right pane of the GFI
ReportCenter. Use the toolbar at the top of the report pane to access
common report related functions:

Report browsing options

M4 »M Browse the generated report page by page.

4 Zoom in/Zoom out.

e Search the report for particular text or characters.

= Go directly to a specific page.

L Breakdown the report into a group tree (e.g. by date/time).

& Print report.

Report storage and distribution options
iy Export the generated report to a specific file format.

rh Distribute the generated report via email.

NOTE: For information on how to configure report storage and
distribution options refer to the ‘Configuring Advanced Settings’
section in this manual.

Adding default reports to the list of favorite reports

ict Selection

IGFI LM guard Metvaark Security Scanner 3.0 ReportPack, j

Default Reports
= [l GFI LaMguard Metwork Secunty Scanner 8.0 ReportPack

H-95F Uglnerahilities Scanning
----- é_' Metwork, Yulnerability Surrnar
----- = Mebwork Yulnerability Trend Run b

----- a-' Yulnerahility distribution by Hos! s s R K =g =g R
..... | Vulnerability distribution by Ope
----- a-_ Securnty Scans Histary

----- ,@ Yulnerability lizting by Categon
----- 48 Vulnerability listing by Host

----- ,@ Yulherability listing by Product
----- ,@ Yulnerahility listing by Severity
----- ,@ Open Trojan Portz by Host

----- ,@ Top SAMS Vulherabilities Status

= 3

? Yulherable Hosts based on Open Parts
-z Open Trojan Ports

- Patch Managerment
-5 Supstemn [nbarmation
- Results Comparizon

Screenshot 13 — Favorite Reports navigation button

You can group and access frequently used reports through the
Favorite Reports navigation button. To add a default report to the list
of favorite reports:
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1. Click on the Default Reports navigation button to bring up the list
of available reports.

2. Right-click on the default report that you to be added to favorites
and select Add to favorites list.

3. Click Yes to confirm.
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Custom reports

Introduction

GFl ReportCenter allows you to create custom reports which are
tailored to your reporting requirements. This is achieved by building up
custom data filters which will analyze the data source and filter out the
information that matches the specified criteria.

Creating a new custom report

To create a custom report:
1. Click on the Default Reports navigation button.

2. Right-click on the default report to be used as template and select
New P Custom Report. This will bring up the ‘Custom Report Wizard'.

Custom Report Wizard |
Scan or date/time range
Specify the scan or datestime range ok which to baze the repart

Reportz are bazed on the zecunty scan results collected dunng past nebwork secunty zcans.

Select the zcan results on which thiz report will be based:

& |ast Scan:
|Jze this option to generate reports based on data collected during the latest netwiork,
zeCurty scan.

= Particular Scan:
Uz thiz optioh to generate reports based on data collected during a particular
network securnty scan.

" Scans over a date/time range:;

|Jze thiz option to generate reportz based on the scan results data collected during a
zpecific datetime period.

< Back |

Screenshot 14 - Selecting the scan data source to use

Cancel |

3. Specify the data source option that will be used to generate the
custom report. This data source refers to scan results from:

e thelast scan

e particular scan(s)

e scans carried out over a specific date/time period.
Click on Next to continue.
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Custom Heport Wizard

Past scan

Select one or more scanzs on which to base the report

From the list below, select the network. securnity scan(z] on which this report will be based.

N

T arget Profile | D ate Completed |
2 File lisk bt Drefault 1/29/2007 4:20:24 P True
2 File lisk bt Drefault 1/28/2007 4:20:24 PM Falze
2 File lisk bt Drefault 1/21/2007 4:20:24 PM - Falze
2 127.001 Drefault 1/20/2007 4:20:24 P True
2 192.168.100.219...  Default 11/29/°2006 101225 ... True
2 192.168.100.219...  Default 11/29/200610:11:19 ... False
A 16"z Drefault 11/29/2006 101 0:00 ... True
2 192.168.100.219...  Default 11/29/°2006 9.51:53 AM  True
o 16" {zd Drefault 11/29/2006 3:10:02 AW True
¢ Back

Cancel |

Screenshot 15 — Selecting the scan data source to use

4. If using the ‘Particular Scan’ option, select the required scan(s) from
the list of network security scans carried out on the corporate network.
Click on Next to continue.

Custom Report Wizard

Date Time

Select the datestime penod on which to base the report

Reports bazed on date and time will gather all scans made during the selected time perod and

will generate rezults bazed on information found dunnd these scans.

N

(" Relative
| -
" Day
| el
" Month
| I~
{* [late range
Eram: | 1/ 1/2007 = mooonsm ==
Ta | 1/31/2007 =l|z35959PM =
¢ Back Cancel

Screenshot 16 - Configuring custom date/time period

5.

If using the ‘Scans over a date/time range’ option, select the
date/time period from which network security scan results will be
gathered. Click on Next to continue.
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Custom Heport Wizard

Data Filters Lo,
Specify any filkers that should be applied on the report Sﬁ“
Add...

+ ] + | | - | fieve | MuveDuwnl

Filkers I I
Operating systemn Equal towWindows <P Edi
Bt |

= 1
Add Filter Property.__. I

Specify the filker condition to apply ta the repaort;

Filter condition:

I Hostname j

Logical relation:

I Equal to j

W alue:
[MARK

Filter property condition when added:

I and j

Cancel |

Screenshot 17 — Specifying data filter conditions

6. Configure the data filter conditions that will be applied against the
selected data source. Click on Next to continue.

NOTE: For more information on how to configure filter conditions,
refer to the section ‘Configuring data filter conditions’ in this manual.

7. Specify a name and description for the customized report. Click on
Next to continue.

8. Click on Finish to finalize your configuration settings.

Configuring data filter conditions

Use data filter conditions to specify which network security scan
data/results will be included in the report. Only scans which match the
specified criteria will be processed and presented within the report.
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Custom Heport Wizard |

Data Filters Lo,
Specify any filkers that should be applied on the report

- | - | favellm | ffave Du:uwnl

Filtess | d

Edif...

Hemave

Il

¢ Back | et » I Cancel |

Screenshot 18 - Custom Report Wizard: Filters dialog

Click on the Add... button to bring up the ‘Edit filter properties’ dialog
and configure the following conditions:

o ‘Filter condition’ — Specify the data source area on which the filter
will focus (for example, select ‘Operating System’ to filter the
events data related to a specific operating system).

e ‘Condition’ — Specify the condition comparison parameter.
e ‘Value’ — Specify the string to which source data will be compared.

For example to generate a report which contains only information
related to Windows XP, configure your filter parameters as shown
below:
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Custom Heport Wizard

Data Filters Lo,
Specify any filkers that should be applied on the report Sﬁ“
Add...

+ ] + | | - | fieve | MuveDuwnl

Filkers I I
Operating systemn Equal towWindows <P Edi
Bt |

= 1
Add Filter Property.__. I

Specify the filker condition to apply ta the repaort;

Filter condition:

I Hostname j

Logical relation:

I Equal to j

W alue:
[MARK

Filter property condition when added:

I and j

Cancel

Screenshot 19 - Filter conditions configuration dialog

For more specific reports, you can limit the range of information to be
displayed by tightening your conditions/search criteria. This is
achieved by configuring and applying multiple data filters against the
selected data source. When more than one filter is used, specify how
these filters will be logically linked. This is achieved by selecting a
logical grouping condition from ‘Filter property condition...” drop down
list.

e Select And to include ALL the scan data information that satisfies
ALL of the conditions specified in the filters.

e Select Or to include ALL the scan data information that matches at
least one of the specified filter conditions.

Example: Using multiple filters

Consider the situation where a custom report has 2 filters configured
as follows:
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Add Filter Property. .. Add Filter Property. .. E

Specify the filter condition to apply to the report: Specify the filker condition to apply to the report;
Filter condition: Filter condition:
I Hostname j I Operating spstem j
Logical relation: Logical relation;
IEquaI [{s] j IEquaI to j
Walue: Value:
|MaRK] [wiindows »H
Filter prapertweandition when added; Filter property candition when added;
Iand j Iand j
Ok I Cancel | Ok I Cancel
Screenshot 20 - Using multiple filters
Parameters Filter 1 Filter 2
Filter condition Hostname Operating System
Logical relation Is equal to Is equal to
Value ‘Mark’ ‘Windows XP’

The data which will be included in this custom report will vary
according to how these filters will be applied against your data. This is
defined through the ‘Filter property condition...” drop-down.

Filters applied Data output

Filter 1 and Filter 2 The report will show:

e All scan data which is related to a host
called ‘Mark’ which runs on ‘Windows XP"’.

Filter 1 or Filter 2 The report will show:

e All scan data related to ‘Windows XP' —
(no matter which host it belongs to)

AND

e All scan data related to a host called

‘Mark’ — (no matter which operating
system it has installed).

Example: Creating a custom report based on network
security scans performed during a particular month

This example demonstrates how to generate a network vulnerabilities
summary report called ‘Network vulnerabilities summary on hostname
Mark for January 2007’. This report will be based on scans:

e Related to a host named ‘Mark’

e Corresponding to operating system ‘Windows XP’
o Performed during the month of ‘January 2007".

To create this report:

1. Click on the Default Reports navigation button.

2. Right-click on the report to be customized and select New »
Custom Report. This will bring up the ‘Custom Reports Wizard'.

3. As soon as the welcome dialog is displayed, click Next.
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Custom Heport Wizard
Scan or date/time range
Specify the zcan or datestime range on which to baze the report

Reports are bazed on the zecurity zcan rezults collected dunng past netwark. security scanz.

Select the zcan resultz on which thiz report will be bazed:

" Last Scan:
|Jze this option to generate reports bazed on data collected during the latest netwark.
FECUMY SCan.

" Particular Scan:
|Jze this option to generate reports bazed on data collected during a particular
network securnty zcan.

f* Scans over a datestime range:

IJze this option to generate reports bazed on the scan results data collected during a
specific datetime period.

< Back Cancel

Screenshot 21 — Selecting the data source to use

4. Select the ‘Scans over a date/month range’ option and click Next.

Custom Heport Wizard

Date Time
Select the datedtime perod on which to baze the repart

Feportz bazed on date and time will gather all scans made during the zelected time period and
will generate rezults based on information found durind these scans.

(" Helative

| []
" Day

| el
{* pdaonth

|-_|anuaf_l,l ﬂ “ear  |2007

" Date range

| ~l =
| | =

< Back | Cancel

Screenshot 22 — Selecting the date/time period

5. Select the ‘Month’ option and specify the following parameters:

Month: ‘January’.
Year: ‘2007'.
6. Click on Next to proceed to the data filters dialog.
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Custom Report Wizard

Data Filters
Specify arw filkers that should be applied on the report

+_[| ;]I _[I _]I fovellm | i = D e | |

Filkers I L

Operating system Equal to Windows XP

and Operating system Equal to MARK Edit.. |

i1
Add Filter Propory.. B
Specify the filker condition to apply to the repart: Specify the filker condition bo apply to the report:
Filter condition: Filter condition:
I Hostname j I Operating system j
Loagical relation: Logical relation:
IEquaI to j IEquaI to j
YWalue: Walue:
[MaRK] [windows 5F
Eilter prapert canditiam when added: Filten property eonditian whet sdded:
Iand j Iand j
(]S I Cancel | oK I Cancel

Screenshot 23 - Filter conditions dialog(s)

6. Click on the Add... button and configure the parameters of filter 1
as follows:

e Filter condition: ‘Hostname’

Condition: ‘Equal to’
Value: ‘Mark’.
7. Click OK to finalize your filter configuration settings.

8. Click again on the Add... button and configure the parameters of
filter 2 as follows:

e Filter condition: ‘Operating system’
¢ Condition: ‘is equal to’

e Value: ‘Windows XP’

o Filter Property condition...: ‘and".
9. Click OK to finalize your filter configuration settings.

10. Click Next and specify the following parameters:

o Report Name: ‘Network Vulnerability summary for January 2007’
e Report Title: ‘Network security scans of hostname Mark’

o Report Description: ‘This report shows a summary of
vulnerabilities found on hostname Mark during January 2007.’

11. Click Next to proceed to the final dialog.
12. Click Finish to finalize your custom report configuration settings.
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Run a custom report

To run a custom report:
1. Click on the Custom Reports navigation button.

2. Right-click on the custom report to be generated and select
Generate.

Editing a custom report

To edit the configuration settings of a custom report:
1. Click on the Custom Reports navigation button.

Custom Heport Wizard

Welcome to the LANguard NS5
Custom Repornt Wizard

NI

Thig wizard will help generate a new customized report bazed on
the following report:

| Software Audit [1)

The "Safhware Audit” repart illustrates the unauthonzed
applicationz over the scan sessions.

You will be azked to select which security zcan data source to
uze and which filters to apply to thiz new custom repart.

Click nest to continue.

< Back | Mewst = I Cancel

Screenshot 24 - Custom Report Wizard: Welcome dialog

2. Right-click on the custom report to be modified and select Edit. This
will bring up the ‘Custom Reports Wizard’ through which you can
make the required changes.

NOTE: For more information on how to configure the parameters of a
custom report refer to the ‘Creating a custom report’ section in this
chapter.

Deleting a custom report

To delete a custom report:
1. Click on the Custom Reports navigation button.

2. Right-click on the custom report to be permanently removed from
the list and select Delete.

3. Click Yes to confirm.
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Adding custom reports to the list of favorite reports

Custom Reports

= [ GFI LAaMguard Metwark, Security Scanner 3.0 RepartPack,

R | =tk Y ulnerability summary for January 2007

Run
Edit
Delete

Add To Favarites List

- e 2

Screenshot 25 - Favorite reports navigation button

You can group and access frequently used reports through the
Favorite Reports navigation button. To add a custom report to the list
of favorite reports:

1. Click on the Custom Reports navigation button to bring up the list
of available reports.

2. Right-click on the custom report to be added to favorites and select
Add to Favorites List.

3. Click Yes to confirm.
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Scheduling reports

Introduction

GFI ReportCenter allows you to generate reports on a pre-defined
schedule as well as at specified intervals. This way you can automate
the generation of reports that are required on regular basis/
periodically.

Further to this, GFI ReportCenter can also be configured to
automatically distribute scheduled reports via email. For every
scheduled report, you can configure custom emailing parameters
including the list of report recipients and the file format (e.g. PDF) in
which the report will be attached to the email.

Use the report scheduling feature to automate your report generation
requirements. For example, you can schedule lengthy reports after
office working hours and automatically email them to the intended
recipients. This way, you maximize the availability of your system
resources during working hours and avoid any possible disruptions to
workflow.

Both default and custom reports can be scheduled for automatic
generation.

Scheduling a report

To schedule a report:
1. Click on the Default/Custom Reports option pane.

2. Right-click on the report to be scheduled and select New »
Scheduled report. This will bring up the ‘Scheduled Report Wizard'.
Click on Next to continue.
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Schedule Report Wizard
Scan or date/time range
Specify the zcan or datestime range on which to baze the report

Reports are bazed on the zecurity zcan rezults collected dunng past netwark. security scanz.

Select the zcan resultz on which thiz report will be bazed:

" Last Scan:
|Jze this option to generate reports bazed on data collected during the latest netwark.
FECUMY SCan.

v Particular Scan:
|Jze this option to generate reports bazed on data collected during a particular
network securnty zcan.

(" Scans over a datestime range:

IJze this option to generate reports bazed on the scan results data collected during a
specific datetime period.

< Back | Cancel

Screenshot 26 - Report Scheduling Wizard: Data-set selection dialog

3. Select the network security scan(s) data to be covered by this
report.

Schedule Report Wizard

Time Schedule
Specify the time schedule to be uzed to automatizally generate the report

Scheduled reports can be generated either once wzing a specific date and time or elze
re-generated using a time frame, starting from a specific time.

" Generate this report [onoe) on the following daytime:

| ~l =

% Generate this report eveny:

Intersal: |'I |H|:uurs ﬂ

irat Ly =
Start datestime; | 1/23/2007 |jme - ==

< Back | Mext = | Cancel |

Screenshot 27 — Report Scheduling Wizard: Time schedule dialogue

4. Specify the report scheduling parameters (date/time/frequency).
Click on Next to continue.
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Schedule Report Wizard

Advanced Settings
Cuztomize repart digtribution and starage options.

r'ou can zend the generated report by email to a target recipient lizt or zave the generated report
in a folder on your file spstem. Click on the Settings button af the relevant section in the dialog to
further configure repart sendingssaving options.

g Click on the Settings button to customize the report storage options and zpecify the file
format and deztination falder where thiz repart will be ztored.

Settingz |

¥ Send by mail

= Click on the Settings button o cuztomize and configure the email zettings which will be
uzed far report distibution.

Settings |

< Back | Mext = I Cancel

Screenshot 28 — Report Scheduling Wizard: Advanced Settings dialog

5. To export the generated report to file, select the ‘Export to file’
option. To customize the report export configuration settings click on
the Settings button underneath this option.

NOTE: For information on how to configure export-to-file settings refer
to the ‘Configuring report export to file options’ section in this chapter.

6. To automatically distribute generated reports via email, select the
‘Send by mail’ option. To customize the email settings used for report
distribution click on the Settings button underneath this option.

NOTE: For information on how to configure email settings refer to the
‘Configuring report emailing options’ in this chapter.

7. Specify a name and description for this scheduled report. Click on
Next to continue.

8. Click on Finish to finalize your settings.

Configuring advanced settings

GFI LANguard N.S.S. ReportPack allows you to export scheduled
reports to a specific file format as well as to automatically distribute
these reports via email. This is achieved using either a set of
parameters (e.g. recipient's email addresses) which are specified on
the fly during scheduled report configuration or using the default set of
report export and distribution parameters configured during the
ReportPack installation.

NOTE: The Report Scheduling Wizard is by default configured to use
the default set of report export and distribution parameters.

Report export formats

Scheduled reports can be exported in a variety of formats. Supported
file formats include:
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Format Description

Use this format to allow distribution of a report on
1 Adobe Acrobat (.PDF) different systems such as Macintosh and Linux
while preserving the layout.

Use this format if you want to further process the
report and perform more advance calculations
using another (external) program such as
Microsoft Excel.

2 MS Excel (.XLS)

Use this format if you want to access this report

9 HiE e (Do) using Microsoft Word.

Use this format to save the report in a format that
Rich text format is small in size and which allows accessibility
(.RTF) through different word processors in different
operating systems.

Configuring report export to file options

To configure the report export to file settings of a scheduled report do
as follows:

_-:;I"' Clizk on the Settings button o cuztomize the repaort storage ophiohs and specify the file
- format and dezstination falder where thiz repart will be stored.

Settings |

Screenshot 29 - Advanced Settings dialog: Export to file settings button

1. From the ‘Advanced Settings’ dialog, click on the Settings button
underneath the ‘Export to file’ option.
Report Storage Options |

Falder Options |

= You can override the default falder options far thiz scheduled
= report

¥ Overide the default falder ophions for this repaort;

Imnn Files\GFINFepantCentersFramework, +3.5\5 avedReportd || ... |

Fiepart format:
| dobe acrobat (% pd) =l

(]3 I Cancel | Apply |

Screenshot 30 - Advanced Settings: Export to file options

2. Select the option ‘Override the default folder options for this report:’
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3. Specify the complete path where the exported report will be saved.
4. Specify the file format in which the exported report will be saved.

5. Click OK to finalize your configuration settings.

NOTE: For information on how to configure the default export to file
settings refer to the ‘Configuring default scheduling options’ section in

this manual.

Configuring report emailing options

To configure the report emailing options of a scheduled report do as

follows:

¥ Send by mail

= Click on the Settings button ko customize and configure the email settings: which will be

uzed for report digtribution,

Settings |

Screenshot 31 - Advanced Settings dialog: Send by email settings button

1. From the ‘Advanced Settings’ dialog, click on the Settings button

underneath the ‘Send by email’ option.

Email Alerts Options

Ernail Options |

J fou can override the default email options for thiz scheduled
report

v Ovemde the default emall options Faor this repart:

To Iadministlatul@lucalhust

)}

(I I

I

rom; IGFIHepDItCentel@1 27001
Server: [127.0.0.1

Boit; |25

[~ SMTP Server requires login

Wsername: I

Eagswnrd: I

Fepart format;
Adobe &crobat [ pf] =]

x]|

o |

Cancel | Apply

Screenshot 32 - Report distribution options

2. Select the option ‘Override the default email options for this report:’

3. Specify the following parameters:

e To/CC: Specify the email address(es) where the generated report

will be sent.

e From: Specify the email account that will be used to send the

report.
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e Server. Specify the name/lP of your SMTP (outbound) email
server. If the specified server requires authentication, select the
option ‘SMTP Server requires login’ and specify the logon
credentials in the ‘User name’ and ‘Password’ fields.

o Report format: Reports are sent via email as attachments. Select
the file format in which to send out your report.

4. Click OK to finalize your configuration settings.

Viewing the list of scheduled reports

GFI ReportCenter 3.5 M=l 3
File Tool: Help
I Schedule Name | Fieport MName | Last Generati... | Mext Generation
Schedule far report MNebwork Wl Metwork Yulnerabilty Surmany 143142007 16:28:46 .
Schedule far report Mebwark Vul...  Metwork Yulnerabilty Trend 143142007 16:29:18 ..
IGFI L&Nguard Network Secuity Scej Schedule for report "Metwork Pat.. Metwork Patching Status 143142007 16:29.41
Scheduled Reports
Fl LaN guard Metwork Security S
cheduled Reports List
cheduled Reparts Activity
] — |
2t l B 5 @ Y|4 | ]
| /

Screenshot 33 - List of Scheduled reports

Click on the Scheduled Reports navigation button to show the list of
scheduled reports which are currently configured for automatic
generation. This information is displayed in the right pane of the
management console and includes the following details:

e Schedule Name: The custom name that was specified during the
creation of the new scheduled report.

o Report Name: The names of the default or custom report(s) that
will be generate.

e Last Generation: Indicates the date/time when the report was last
generated.

o Next Generation: Indicate the date/time when the report is to be
next generated.

e Description: The description that you have entered for each
schedule.
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Viewing the scheduled reports activity

GFI ReportCenter 3.5 M= B
Fle Tooks Help

Product Selection

GFI LANguard Netwark Sec... Infermalion  Scheduled repart emaiied successiull.
@)1/30/2007 9... GF LANguard Netwark Sec...  Information S cheduled report expaited successfully 1o folder.
(@)1/30/2007 ... GFI LiNguard Newwark Sec..  Information  Gienerating scheduled repon "5 chedule for repon Network Vulnerakiity Trend™ .
Scheduled Reparts () 1/30/2007 9. GFI LiHguard Network Sec...  Information  Staring to generate scheduled report“Schedule for report Network Vulherakity Tre
()1/30/2007 9. GFI LiNguard Network Sec..  Information  Firished generating scheduled report
5 8] GFI LANguard Network Securty Scanner 0 ReponPack || (3)1,30/2007 9. GFI LaMguard Network Sec...  Information  Scheduled report emaied successiully
: Scheduled Reports List @) 1/30/2007 8. BFI LAMguard Network Sec..  Information S cherled report exported successfuly o folder.
T Scheduled Reports Activiy 3)1/30/2007 8. GFI LaMguard Network Sec . Information  Generaling scheduled report S chedule for report Network ulnerabilty Summary™
()1/30/2007 8. GFI LiNguard Network Sec...  Information ~ Starling to generale scheduled report “Schedule for repot Network Vulnerabity Su

[GFI LsNouard Network Securty Scanner .0 RepotPack. 7]

% Favorite Reports

w| Default Reports

) CustomReports
|5 Scheduled Reports

£ Options

2 Help

Screenshot 34 - Schedule activity monitor

N

GFI ReportCenter also includes a schedule activity monitor through
which you can view events related to all scheduled reports that have
been executed.

To open the schedule activity monitor, click on the Scheduled
Reports navigation button and select the Scheduled Reports
Activity node. This will bring up the activity information in the right
pane of the GFI ReportCenter management console.

The activity monitor displays the following events:

4 . Information: The scheduled report was successfully executed
and sent by email and/or saved to disk.

& - Warning: The scheduled report was not executed because
product license is invalid or has expired.

& - Error: The scheduled report was not executed due to a particular
condition/event. Typical conditions include:

e Errors when attempting to save the generated report to a
specific folder (for example, out of disk space).

e Errors when attempting to send the generated report via email
(for example, the SMTP server configured in the GFlI
ReportCenter settings is not reachable).

The activity monitor records and enumerates the following information:
o Date: The date and time when the scheduled report was executed.

e Product name: The name of the GFI product to which the report
belongs.

e Type: The event classification - error, information, or warning.

e Description: Information related to the state of a scheduled report
that has been executed. The format and contents of the activity
description vary, depending on the event type.
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NOTE: The description is often the most useful piece of information,
indicating what happened during the execution of a scheduled report
or the significance of the event.

Enable/disable a scheduled report

Scheduled reports can be enabled or disabled as required. Use the
Scheduled Reports navigation button to view the list of scheduled
reports as well as to identify their current status. The status of
scheduled reports is shown through the icon included on the left hand
side of each schedule:

L Indicates that the scheduled report is disabled.

™ _ Indicates that the scheduled report is enabled/pending.

To enable or disable a scheduled report, right-click on the respective
report and select Enable/Disable accordingly.

Editing a scheduled report

To make changes to the configuration settings of a scheduled report:
1. Click on the Scheduled Reports navigation button.

2. Right-click on the scheduled report to be re-configured and select
Properties. This will bring up the ‘Scheduled Reports Wizard'.

Schedule Report Wizard

Welcome to the LANguard NSS
Schedule Report Wizard
Thiz wizard will help you zchedule the following repoart:

| Schedule for report 'Metwark Yulnerability Surmmany

The "Metwork. Yulnerability Suriman" iz an executive summary
zhowing wulherability counts for different categones. This repart
alzo identifies the top most vulnerable hosts and products, as well
ag the mogt common wulnerabiliies detected ...

Click nest to continue.

4 Bach | et = I Cancel

Screenshot 35 - Scheduled Reports wizard

3. Click on Next and perform the required changes. For information on
how to configure the parameters of a scheduled report refer to the
‘Creating a scheduled report’ section in this chapter.
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Deleting a scheduled report
To delete a scheduled report:
1. Click on the Scheduled Reports navigation button.

2. Right-click on the scheduled report to be permanently removed
from the list and select Delete.

Example: Scheduling a report

This example demonstrates how to schedule a network vulnerability
summary report which will:

e Generate the first report on 02/01/2007 at 20:00.
e Continue generating the same report on a monthly basis.

e Export the generated report(s) to folder ‘C:\Monthly Reports’ in
PDF format.

o Email the generated report using the following custom parameters:
o0 Send from email account: ‘RC_Admin@gfi.com’
0 Send to email account: ‘IT_manager@gfi.com’
0 SMTP server details: '120.11.120.11.

To create the scheduled report:

1. Click on the Default Reports navigation button.

2. Right-click on ‘Network Vulnerability Summary’ and select New »
Scheduled Report. As soon as the welcome dialog is displayed click
Next.

Schedule Report Wizard |

Scan or date/time range
Specify the scan or datedtime range on which to base the report

Reports are bazed on the security zcan resultz collected during past netwaork zecurnity scans.

Select the zcan resultz on which this report will be bazed:

" Last Scar:
IUz& thiz option to generate reports bazed on data collected during the latest netwaork:
secunity scan.

" Particular Scarn;

IJz& thiz option to generate reportz bazed on data collected during a particular
netwark, securnty scan.

% Scans over a datestime range:

Uze thiz option to generate reports bazed an the zcan results data collected during a
specific datetime period.

< Back | Hext = I Cancel

Screenshot 36 - Select network security scan(s) data

3. Select the option ‘Scans over a date/time range' for data to be
covered by this report and click Next.
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Schedule Report Wizard

Date Time
Select the datetime period on which to base the report

Reports bazed on date and time will gather all scanz made during the selected time period and
will generate rezults bazed on information found durind these scans.

{+ Relative

Today ﬂ

Yesterday
Last zeven days
| Thiz ranth

" Date range

| ~l =
| ~l =

< Back | Mext = | Cancel

Screenshot 37 - Select date/time of network scan

4. Select the option ‘Relative’ and from the provided drop down list
select ‘Last month’. Click on Next to proceed to the next dialog.

Schedule Report Wizard

Time Schedule
Specify the time schedule to be uzed to automatizally generate the report

Scheduled reports can be generated either once wzing a specific date and time or elze
re-generated using a time frame, starting from a specific time.

" Generate this report [onoe) on the following daytime:

| ~l =

% Generate this report eveny:

Intersal: |SD |Da_l,l3 ﬂ

Start datedtime: | 2/ 1/2007 x| |zn0cco0PM 0 =

< Back Cancel

Screenshot 38 — Specifying the scheduling options

5. To generate this report on a monthly basis, select the option
‘Generate this report every:’ and set the interval to ‘30 Days’ .

6. Set the start date to ‘02/01/2007’ and time to ‘20:00'. Click Next to
continue.
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Schedule Report Wizard

Advanced Settings
Cuztomize repart digtribution and starage options.

r'ou can zend the generated report by email to a target recipient lizt or zave the generated report
in a folder on your file spstem. Click on the Settings button af the relevant section in the dialog to
further configure repart sendingssaving options.

gl Click on the Settings button to customize the report storage options and zpecify the file
= format and deztination falder where thiz repart will be ztored.

Settingz
[+ Send by mail

= Click on the Settings button o cuztomize and configure the email zettings which will be
uzed far report distibution.

Settings
< Back | Mext = | Cancel

Screenshot 39 - Advanced Settings dialog

7. From the ‘Advanced Settings’ dialog, click on the Settings button
underneath the ‘Export to file’ option.

Report Storage Options

Falder Options l

You can override the default falder options far thiz scheduled

“0  repart

[v DOverride the default folder options for this report:

|E:'\Mnnthly Reparts
Fiepart format:
| &dobe Acrobat [~ pdf] =l

1 L™
icrosoft Excel [*=ls]
Microzoft Word [*.doc]
Fich Test Format [*.rtf]

(]3 | Cancel Apply |

Screenshot 40 - Advanced Settings: Export to file options

8. Select the option ‘Override the default folder options for this report:’

9. Specify the complete path where this report will be saved i.e.
‘C:\Monthly Reports’.

10. From the report format drop down select ‘PDF’ and click OK.
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W Send by mail

= Click on the Settings button o cuztomize and configure the email zettings which will be
uzed far report distibution.

Screenshot 41 - Advanced Settings dialog: Send by email settings button

11. From the ‘Advanced Settings’ dialog, click on the Settings button
underneath the ‘Send by email’ option.

Email Alerts Options |

Ernail Options |

rou can overrde the default email ophions for thiz scheduled

J repoart

W Ovemde the default email options For this repart

To Iadministlatur@lucalhust
CC: |
From: IGFIHepUItEentel@'l 27.001

Sever [127.0.01 Bot: |25

[~ SMTP Server requires login

zern nanme: I

Eazsword I

Bepart format;
Adube Acrabat [* pf] =]

(]3 I Cancel | Apply |

Screenshot 42 - Report distribution options

12. Select the option ‘Override the default email options for this
report:’

13. Specify the following parameters:
e To: ‘RC_Admin@dfi.com’

e From: ‘IT_manager@gfi.com’

e Server: 120.11.120.17".

14. From the report format drop down select ‘PDF’ and click OK to
finalize your email settings.
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Schedule Report Wizard |
Hame and Descrption
Specify the name and deszcription for this custam report

The name. title and descrption of a cugtom report will be uzed to uniquely identify the report
through the zet of custom reportz. The cuztom repart name must be unigue.

Beport name:

IMDntth network, vulnerability summary repart

Beport Title:

IMDnthI_I,I netwark, vulnerability surmary repart

Report dezcription:

Thiz repoart iz generated on a monthly basiz. |t shows a summary of network, ;I
wulherabilities on zcan carmed out during the previous month,

[

I | Shav Cover Fage

< Back | 1

Screenshot 40 — Custom report name and description

Cancel |

15. Click Next and specify the following parameters:
o Report Name: ‘Monthly network vulnerability summary report’
o Report Title: ‘Monthly network vulnerability summary report’

e Report Description: This report is generated on a monthly basis.
It shows a summary of network vulnerabilities on scans carried out
during the previous month.

16. Click Next to proceed to the final dialog.
17. Click Finish to finalize your custom report configuration settings.
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Configuring default options

Introduction

The GFI LANguard N.S.S. ReportPack allows you to configure a
default set of parameters which can be used when generating reports.
These parameters are first set during installation. However, you can
still reconfigure any of these parameters via the Options navigation
button and the Tools menu provided in the GFI ReportCenter
management console.

GFI ReportCenter 3.5 [_ (O
File  Tools Help

4 » 2=
n -
Product Selection EZGFI SECURITY & MESSARING SDWA@

Database Source Selection

I GFI LANguard Metwork Security Scanne\j

GFI LANguard Network Security Scanner 8.0 ReportPack
= GFI LAN guard Metwork. Security Scann Copytight () 2000-2005 GFI Software Lid.

[t = Database Type: MS Access
3 Import/E sport Configuration Database Path: C:\Program Files\SFRLANguard Networ k Security Seanner 8
[T Wersion Information ReportPackiSampleDB\SamplaLNS 56.mdb
@ Licensing

NOTE : To change the database backend between different database types, right click on Database
Source and select "Set Databaze Source "

2006. Al rights ved. GFl Software Ltd

Screenshot 43 - Options navigation button and Tools menu

Through the Options navigation button you can configure the
following parameter:

o Database source: Use this node to specify the database backend
from where the ReportPack will extract the required reporting data.

Through the Tools menu you can configure the following parameters:

e Default scheduling settings: Use this menu option to configure
the default export to file parameters and report emailing
parameters of scheduled reports.

You can also backup your configuration settings for the ReportPack
through the Import/Export Configuration node in the Options
section. Exported configurations may be imported into a separate GFlI
ReportCenter instance, provided that the same ReportPacks are
installed on both instances.
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Configuring database source: Microsoft SQL Server
To configure MS SQL Server your database source:
1. Click on the Options navigation button.

2. Right-click on the Database Source node and select Set Database
Source... This will bring up the database source configuration dialog.

Databaze Source Ed

Database Source |

— Databasze settings

Databasze Type:
M5 SOL Server j

Pleaze zpecify the name or IP of the machine containing the SCL
Server / MSDE databaze to use:

Server; |suL5EHvEH =]

v Usze SOL Server Authentication

Uzer: Isa

Pazsword: I xxxxxxxxxxxxxxxxxxx :1

Ok I Cancel | Apply |

Screenshot 44 - Database source configuration dialog: SQL Server

3. Select ‘MS SQL Server as the database type from the provided list
of supported databases.

4. Specify the name or IP address of your MSDE/MS SQL Server
database backend.

5. To use the credentials of an SQL Server account, select the ‘Use
SQL Server authentication’ option and specify the user name and
password in the provided fields.

NOTE: By default, the GFI LANguard N.S.S. ReportPack uses
Windows logon credentials to authenticate to the SQL Server.

6. Click on OK to finalize your configuration settings.

Configuring database source: Microsoft Access
To configure Microsoft Access as your database source:
1. Click on the Options navigation button.

2. Right-click on the Database Source node and select Set Database
Source... This will bring up the database source configuration dialog.
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Database Source E

Database Source I

— Databaze settings

@@ Databaze Tupe:

IMS Access j

Flease specify the full path [including filename] of the database
backend:

C:A\Program Files\GFISLAM quard Metwark, Security Browsze... |

Cancel | Apply |

Screenshot 45 - Database source configuration dialog: MS Access

3. Select ‘MS Access’ as the database type from the provided list of
supported databases.

4. Specify the complete path to the database backend. If the database
source is not stored locally, specify the complete path using Universal
Naming Convention (UNC).

(e.g., \\Security_Server\Program  Files\GFI\LANguard  Network
Security Scanner 8.0\Data\scanresults.mdb).

5. Click on OK to finalize your configuration settings.
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Viewing the current database source settings

GFI ReportCenter 3.5 Hi=] 3

File Tool: Help
n -
%GFI SECURITY & MESSAGING SDFTW@

<« » 2=|H
Database Source Selection

IGFI LaMguard Metwork, Security Scanne\j

GFI LANguard Network Security Scanner 8.0 ReportPack

Copyright () 20002005 GFI Sofhuare Ltd

etwork Security Scann
D e Database Type: MS Access
Import/E xport Configuration Database Path: C:Frogram Files\BFRLANguard Metwork Security Scanner 8

“ersion Information ReportPackiSampleDE\SampleLMS S2.mdb
fg Licensing

NOTE : To change the databaze backend between different database types, right click on Datshase
Source and select "Set Databaze Source. ..

2006, Al rights

Screenshot 46 - Database source configuration settings

After configuration, you can view the current database source settings
by clicking on the Database Source node.

Configuring default scheduling settings
To configure the default settings to be used by scheduled reports:

GFI ReportCenter 3.5
File | Toolz | Help

4 | Drefault Scheduling Dptions

LNSS ReportPack

Screenshot 47 - Default scheduling options node

1. From the pull-down menu, click on the Tools » Default Scheduling
Options.

2. Configure the required parameter as described in the ‘Configuring
Advanced Settings’ section of the Scheduling Reports chapter.

Importing/Exporting the configuration

GFl ReportCenter 3.5

File | Toalz Help

| Import/E #port Configuration...
! Exit Alt+F4 !

Screenshot 48 — Import/Export Configuration node
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The GFI ReportCenter allows you to backup your configuration
settings for the ReportCenter and all ReportPacks through
Import/Export Configuration... in the File pull-down menu. Settings
are exported for:

o Default scheduling options
e Custom reports

e Scheduled reports

e Favorite reports.

The configuration is backed up into an XML file which may be
imported into a separate GFI ReportCenter instance, provided that the
same ReportPacks are installed on both instances.

You can also import/export the configuration for a particular
ReportPack through the Import/Export Configuration node in the
Options section of the ReportPack.

Exporting the configuration
To export the GFI LANguard N.S.S. configuration:

Import/E xport Configuration

|mport/E xport |

i_ Import/E xport ReportCenter and ReportPacks configurations.

The import/export configuration functionalitiez can be used to perform
backups of scheduled reports, custom reports, favarite reports and other
options. The exported configurations can alzo be imported into a separate
ReportCenter instance, provided that the zame FeportPacks exizt on both
instances.

Specify the action to perform:
= Import configuration options

¥ Export configuration options

Specify which configuration optionz to import/expart;

¥ ReportCenter options
¥ BeportPacks' custam, scheduled and Favarite reports + options

Specify the path and filename of the file to impart/expart:

IE:'\EUnfig_B KPYRC_Configs =<kl

ak | LCancel |

Screenshot 49 — Import/Export configuration dialog

1. From the pull-down menu, click on the File » Import/Export
Configuration... . This will bring up the configuration dialog.

2. Select the option ‘Export configurations options’.
3. Specify which configuration options to export.

4. Specify the path and filename of the XML file to export. Click on OK
to proceed with the export.
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GFI ReportCenter

é |  Export process completed successfully.

Dretails:

@ Exparting RC Scheduling zettings.

E@ Expoing settings for GFI LANguard Metwork Security Scar
@ Exporting custorm reports.

: @ Exporting zcheduled reports.

@ ExpoHing favorite reports.

----- @ Expaorting connection string.

| | i

o6 | petsis |

Screenshot 50 — Export configuration success

Importing the configuration
To import the GFI LANguard N.S.S. configuration:

Import/E xport Configuration Ed
|mport/E xport |

i__ Impart/Export ReportCenter and ReportPacks configurations.

The import/export configuration functionalities can be used to perform
backups of scheduled reports, custom reports, favarite reports and other
optionz. The exported configurations can alzo be imported into a separate
FiepartCenter instance, provided that the zame FeportPack: exist on bath
instances,

Specify the action to perform:

% Import configuration options

€~ Export configuration options

Specify which configuration optionz to import/expart;
¥ ReportCenter optiohs
¥ BeportPacks' custom, scheduled and favorite reports + options

Specify the path and filename of the file to impart/expart:

II::'\EUnfig_B FPYRC_Configs =<kl |

ak LCancel |

Screenshot 51 — Import configurations dialog

1. From the pull-down menu, click on the File » Import/Export
Configuration... . This will bring up the configuration dialog.

2. Select the option ‘Import configurations options’.
3. Specify which configuration options to import.

4. Specify the path and filename of the XML file to import. Click on OK
to proceed with the import.
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GFI ReportCenter

i Importing from C:A\Config_BKPYRC_Configs #kL file completed successfully.
- l) Fleaze close and restart GFI ReportCenter to load up with the imported items.

Screenshot 52 — Import configuration success

5. Close and restart GFI ReportCenter to activate the imported items.
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General options

Entering your license key after installation

If you have purchased a ReportPack, enter your license key using the
Options P Licensing node (no re-installation/re-configuration
required)

NOTE 1: You must purchase a different license key for every product
ReportPack to be installed and accessed through the GFlI
ReportCenter framework.

For example, to install both the GFI Network Security Scanner 8.0
ReportPack and the GFI EventsManager 7.0 ReportPack, you must
purchase 2 separate license keys, one for each product ReportPack.

NOTE 2: Entering the license key should not be confused with the
process of registering your company details on our website. This is
important since it allows us to give you support and notify you of
important product news. You may register and obtain your GFI
customer account from: http://www.gfi.com/pages/regfrm.htm.

To input your product ReportPack license key:

Product Selection

[ALL PRODDCTS

Screenshot 53 — Product Selection drop down list

1. Select the respective product (e.g. ‘GFI LANguard N.S.S. 8.0") from
the Product Selection drop down list.

2. Click on the Options navigation button.

3. Right-click on the Licensing node and select Set Licensing....
This will bring up the ‘Licensing’ dialog.
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Licensing

—Curent license key

. ReportPack:
A IGFI LAMquard Metwork Security Scanner 8.0 ReportPack

Licenzing status:

IEvaIuatinn WErEion

Evaluation status:

IEEI days evaluation, & days passed

Licenze key:

IEvaIuatinn

—Mew licenze key

% Enter your news ReportPack license key:

K I Cancel | Al

Screenshot 54 - Licensing dialog

4. Type in the ReportPack license key.
5. Click on OK to finalize your entry.

Viewing the current licensing details

To view your current licensing details, click on the Options navigation
button and select the Licensing node. The licensing details will be
displayed in the right pane of the management console.

Viewing the product ReportPack version details

To view the version information of your product ReportPacks:

1. Select the product ReportPack from the Product Selection drop
down list.

2. Click on the Options navigation button and select the Version
Information node. The version details will be displayed in the right
pane of the management console.

Checking the web for newer builds

Periodically GFI releases product and ReportPack updates which can
be automatically downloaded from the GFI website. To check if a
newer built is available for download:

54 e General options GFIl ReportCenter



Program Yersion Properties

General I

Wersion Information

GFI LAMNguard Metwork, Security Scanner 8.0 ReportPack,
Copyright [¢] 2000-2008 GFI Software Ltd,

GFI LaMquard Metwork Security Scanner 8.0 ReportPack

There iz no newer build available.

Version: 8.0 Build: 200700121

LCheck for latest wersion on website

Build Updates
’7 W Check for newer builds on startup

Ok I Cancel |

Screenshot 55 - Version Properties: Check for newer builds dialog

1. Select the respective product (for example, GFI LANguard N.S.S.
8.0 Reports) from the Product Selection drop down list.

2. Click on the Options navigation button.

3. Right-click on the Version Information node and select Checking
for newer builds...

NOTE: GFI LANguard Network Security Scanner 8.0 ReportPack is
configured by default to check for newer builds on startup.
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Appendix: GFI LANguard Network
Security Scanner default reports

Vulnerabilities scanning reports

Network vulnerability summary

Scan refarence : 192.168.100.2-192.168.100.254
Scan date & time : 29-Now-2006 10:12

Hosts Severity Level Distribution Top 10 Vuinerable Hosts {by Severity)

IF Address Host Name Saverity
High Med  Low
B80.164.37.238 TestComph 10 [ 8
0* 2016437214 TestCompi 7 2 8 #e
| B0.164.37 236 Cluster_s2 7 1 i0
y 80.164.37 66 FSERVER 7 0 7
L:__I\‘-' - £0.164.37.114 TestHost 5 2 7
£0.164.37.220 TESTSTATION 3 0 5
80.164.37 208 FinExsc 2 2 8
[— g y B0.164.37 64 MARKXP 2 1 o
High 55 25 20.184.378 Workstation_1 2 1 8
Medium 2 10 £0.185.29.75 Workstation_2 2 1 g
Low 140 a5
Hosts Vulnerability Level Distribution
Vulnerability [
[ Count
High 18
Medium 1
Lowr 72
Mot Assigned
Total 41

Screenshot 56 — Sample report showing network vulnerability summary

Chart displaying vulnerability severity distributions

List showing the top 10 most vulnerable host machines ordered by
severity

Chart displaying vulnerability level distributions across host machines on
the network

00e

56 ¢ Appendix: GFI LANguard Network Security Scanner default reports GFIl ReportCenter



Vulnerability Count by 05 Distribufion

W High
o* W Wediom
i 0 Lewy

HP Windows Windows Windows Wingows XP Windows XP
2000 Sernver 2003 w4
Operating System Severity Distribution
Total High Med. Low

HP 1 [V o 1
Windows 20 a 2 10
Windows 2000 25 10 ] &
‘Windows Server 2003 33 1 1] 2
Windows XP 119 23 12 B2
Windows XP x84 18 3 1] 15

Screenshot 57 — Sample report showing network vulnerability summary

o Chart displaying the vulnerability distribution for each operating system on
the network

Vulnerability Distribution (by Category)

FTR ]
W High
liscellanseow W et
O Leww
Registry
RPC
e# Security
Prod.
Service
Services
Softwars
Web
-
0 20 40 80 =l 100 120
Inerability Category Severity Distribution
Total High Med. Low
FTP 12 1] 0 12
Miscellaneous 22 20 1] 2
Registry 114 2 17 o5
RPC 0 10 0 1]
Security Prod. 3 3 0 o
Service 1 1 1] 1]
Serices 1B bl 2 T
Softesare - 1 2 3
Web 30 2 o 21

Screenshot 58 — Sample report showing network vulnerability summary

o Chart displaying vulnerability categories and their distribution
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Vulnerability Distribufion (by Timestamp)

Last Three o Hich
Manths. W Aediom
O L
e* Last Year
Older than
One Year
1 | 1
1] a0 &0 120 160 200
Inerability Category Severity Distribution
Total High Med. Low
Last Three Months [1] (] o 0
Last Year n 12 1 14
Older than One Year 138 43 20 128

Screenshot 59 — Sample report showing network vulnerability summary

@ Chart displaying the vulnerability distribution over time

Top 10 Most Commaon Vulnerabilities:

Product Timestamp References Tyoe Sieverity Count
Unknown 2002-01-D1 Unknown Regiztry Low 12

[~
3

Product Timestamp Referznces Tyoe Sieverity Count
Unknown 2002-01-01 Unknown Regisiry Lowr 12

Product Timestamp Refersnces Tyoe Sieverity Count
Unknown 2002-01-01 Unknown Regisiny Lowr i8

Product Timestamp Refersnces Tyoe Sieverity Count
Unknown 1889-06-07 CVE-1999-0658 Regisiny Lowr 18

Product Timestamp Refersnces Tyoe Severity Count
Unknown 2002-01-01 Unknown Regisiny Lowe 18

Product Timestamp References Type Severity Count
Unknown 2002-01-01 Unknown Regisiny Medium 13

Product Tirmestamp Referznces Typ= Sewerty  Count
Unknewn Unknown Unknown FTF Low 11

Product Tirmestamp References Typ= Sewerty  Count
Unknzwn 2008-08-11 CVE-2008-3086  Sarvices High k]
Product Tirmestamp References Type Sewerity  Count
Unknown 1889-08-11 CWE-19098-0268  Web Laow 8

Prosduct Timestamp Refersnces Type Sewerity  Count
Unknaown 2004-04-20 CVE-2003-0813 RPC High 3]

Top 10 Most Vulnerahle Products

Products Severity Distribution
High Med. Low
e* Product 2 34 1 2 21
Froduct? 2 5 1 1@
Productt 18 3 1 14

Screenshot 60 — Sample report showing network vulnerability summary
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Chart displaying the 10 most common vulnerabilities

(8]

Chart displaying the 10 most vulnerable products

Use this report to:

Display vulnerability counts for different categories

Identify the 10 most vulnerable host machines

Identify the 10 most vulnerable products

Identify the 10 most common vulnerabilities.

Network vulnerability trend

Q9 w

1400

1200

1000

500

600

Vulnerability Count

400

200

0

Vulnerability detections over time

-l @High
- @Madium
e i-@Low
1 @Total
I e
|

g -

Past Scans

This trend report was genarated from data in the following scans :

Default £0.134.200.10 - 80.134.
Default 20.134.200.10 - 80.134,
Default £0.134.200.10 - 80.134.
Default 20.134.200 10 - BD.134.

Default 20.134.200.10 - B0.134,
Default 80.134.200.10 - BQ.134,

Default 80.134.200.10 - £0.134.200
Default 20.134.200 10 - 80134 200 157
Default 20.134.200.10 - B0.134,

Default 80.134.200.10 - BQ.134,

Default £0.134.200.10 - B0.134,

Default 20.134.200 10 - B0 134

Default 20.134.200.10 - B0.134,

Default 20.134.200.10 - 80.134.200.157
Default £0.134.200.10 - B0.134,

Default £0.134.200.10 - £0.134.

Default 280.134.200.10 - B0.134.

Default 80.134.200.10 - BQ.134,

Default £0.134.200.10 - B0.134,

Default £0.134.200.10 - £0.134.

Default 20.134.200.10 - 80.134.200.157

Screenshot 61 — Sample report showing network vulnerability trend

Chart displaying past scans and vulnerability totals for each scan

(2]

List of past scans and respective scan profiles

Use this report to:

Graphically illustrate how the number of vulnerabilities on the
network has changed over a given time span.
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Vulnerability distribution by host

Scan reference : 192,168,100,2-192,168, 100,254
Scan date & time: 20-Mov-2006 9:51

Severity Distribution

Low Med High col

19216810011 0 o o 0 i] ] ] il il ] ] ] ] i] i] ] ]
18216810012 o 0 o o 0 ] ] o o ] ] ] ] 0 0 ] ]
BOGOAN
19216810013 6 5 o 1 o o o il 5 o o 1 ] 0 0 ] ]
STELI
192 16810014 i ] o i o o o il il o o o ] 0 0 ] ]
SORIN
192. 16810045 i ] o i o o o il il o o o ] 0 0 ] ]
CRISTI
192.168.10018 i ] o i o o o il il o o o ] 0 0 ] ]
BOGOY
152188 10017 i o i i o o o i i o o o o o o o o
BOBEY
182.168.100.18 0 0 o 0 i i i 0 0 i i i i i i i i
NSM_HPHES
18218810020 3 5 1 H 0 0 0 0 [ 0 0 0 0 1 0 0 0
CALDEY
162.168.10023 1 1 o 0 o 1 o o o o o o o o o o o
MASTERSERY
162.168.10024 [ 5 o 1 o o o o 5 o o 1 o o o o o
HORI
3?32-139-10333 H 2 i i 2 0 0 i i 0 0 0 0 i i 0 0
162.168.10023 0 0 o 0 o o o o o o o o o o o o o
cE1
162.168.10029 i 0 o 0 o o o o o o o o o o o o o
MIHAI
192.168.100.20 1 1 o D i] 1 ] il il ] ] ] ] i] i] ] ]
MASTER
162.188.100:31 3 H o 1 o o o o 5 o o 1 o o o o o
NSMZKESTD

L J [ 1 J [ J

3 w g

o 2] 3]

Screenshot 62 — Sample report showing vulnerability distribution by host

o List of IP addresses and host names on which vulnerabilities were
detected

o The number of low, medium and high severity vulnerabilities detected on
each host

o The number of vulnerabilities detected on each host distributed by
vulnerability category

Use this report to:

e Generate statistics showing vulnerability counts for each host
machine.

60 e Appendix: GFI LANguard Network Security Scanner default reports GFIl ReportCenter



Vulnerability distribution by operating system

Scan reference: 192.168,100.2-152.168.100.254
Scan date & time: 29-Mov-2006 10:12

Severity Distribution Vulnerability Categories
Dperating System/ SP Total Low Med High CG 7 Mi s o RF

D-Link DiL-Z 100AF (-2 100AF| 0 0 0 0

o o o o o 0 0 0 0 0 o 0 0
SP. None
HP 1 1 0 o o 1 o o o o 0 0 0 0 ] 0 0
SP. None
Unkn o i 0 i 0 ] ] ] ] ] 0 i i i i il i i
SF: None
Windovs 0 10 2 & i 3 i i i 1 i 1 i i o i i
SP. None
ind ouws 2000 24 8 6 10 4 1 o o ] ] i 1 i i o i i
SP 4
find ous 2000 1 1 o o o o o o o o o o o o o o o
SP. None
hind s 824 i ] i ] o o o o o ] i i i i o i i
5P Mone
find ous NT o 0 o 0 ] ] ] ] ] 0 o o o o o o o
SF: None
wiindows Senver 2003 14 7 o 7 H ] ] ] 5 0 o 1 o o o o o
5P Gold
find ous Senve r 2003 17 1 o 4 1 o o o 11 o o 2 o o o o o
SP 1
Wiind o Server 2003 2 2 o 0 2 o o o o 0 o o o o o o o
5P Mone
lind ous 5 o 0 o 0 ] ] ] ] ] 0 o o o o o o o
5P Mone
i d s 5 12 1 1 H 4 1 ] ] 6 0 o 1 o o o o o
sP 1
iind e XP 14 H 2 5 i i i i 1 o i 1 i i o i i
5P Gold
i od ouigz 5P a7 66 10 1 15 [ ] ] 56 ] o o o 3 i o o
sP: 2
[ J [ J [ J

" " g

o 2] (3]

Screenshot 63 — Sample report showing vulnerability distribution by operating system

o List of operating systems and service packs affected by one or more
vulnerabilities

o The number of low, medium and high severity vulnerabilities detected on
each operating system

o The number of vulnerabilities detected on each operating system
distributed by vulnerability category

Use this report to:

e Generate statistics showing vulnerability counts for each operating
system.
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Security scans history

Maost Scanned Systems Least Scanned Systems

BO.16520.75 Workstation_2 5 80.164.37.220 TESTSTATION 1
125.143.23.4 TestComp3 4 80.164.37.11 DOTest4s 1
B0.164.3728 TestCompd 2 80.164.37.11 TestZempl 1
o* B0.164.37.13 FinanceDep 2 80.164.37.112 TestCempi 1 *e
B0.164.37.12 Jack 2 80.164.37.114 TestHest 1
£0.164.37.10 TestFarm_PC1 2 80.164.37.145 DEVEL 1
B0.103.175.40 Homed 2 80.164.37.152 SERVER 1
B0.164.37.23 MASTERSERV 2 80.164.37.154 D-Link Access Point 1
B0.132.13.182 JarnesH 2 80.164.37.170 DTestid 1
B0.164.37.14 TestFarm_PC4 2 80.164.37.208 FinExec 1

Most Used Profiles

Profile Profile Count

(3 L)

Fuil Scan

Mizsing Faiches

Softacre Aucit

Full Scan
Vulnerabilities
Trojan Ports
Softwars Audit
Missing Paiches

Screenshot 64 — Sample report showing security scans history

4

— P R

List showing the host machines with the highest number of scans and the
respective scan count

©e

List showing the host machines with the lowest number of scans and the
respective scan count

Chart displaying scan profile usage

3
192162 1008 NiA
192 16810011 LN
192 16810059 LN
192,168 10015 CRISTI

o * 19216810020 TESTESTATION
19262 100214 NiA
192 68100211 IWIRTUALZ
192 G2 00206 W2O0GA
192,168 10020 CALDEY
19216810019 NS M _ P X5
192162100170 BOGWXP
192 168 10017 BOBEY
192 168 10016 BOGDY
192,168 100152 SERVER

art DateTime

A1/28/2006
A4/28/2006
o * /2872006
A1/28/2006
A1/728/2006
A1/20/2006
A4/20/2006
/2972006
11/29/2006

33T P
22 33PM
243 10PM
247 54PM
910024
9:51:534M
401000404
10111950
10:1 22550

112920068
1152952006
115202006
1442052005
112920065
11292006
112952006
115202006
114202005
11292006
112920068
1152952006
115202006
1442052005

A0:1 118804
10122504
10122580
10:1 22580
01225840
A0:1 2255
10122504
10122580
10122580
A0:1 2254
A0:1 225840
10122504

1270041 Default res
file:list it Default Ma
file:listbd Default Mo
fila:listbd Default iCH
g Default RiCH
192.168.100.2-192 162100253  Default as
& zrd Default es
192.168.100.2-192 162100253 Default Ma
192.168.100.2-192 162100254 Default s
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Screenshot 65 — Sample report showing security scans history

o List showing date and time of the last scan performed on each host

o List showing all scans performed

Use this report to:

e Display information and statistics on all network security scans
performed.

Vulnerability listing by category

Scan reference: 192,168.100,2-192,1658,100.254
Scan date & time: 1102902006 10:12:254M

CATEGORY: FTRP

o*\-‘ulnerability’. FTP anonymous aceess alloved—

Product: MEA,

Severity: Lo

Ti mestamp: [EEY

Affected Hosts: [ENEE = Host Hame Opersting = S
192 162 100ANBOGWXP Mindows XP 2

e * 192 168 100 21 VIR TUALZ Mindows XP 2

192 16810021 Wind ouus
192 165810023 MASTERSERY Wind ouus
192 168 10022M G 1 Mindows XP 2
192, 168, 100230 >4 Mindows XP 1
192 168 100Z=LB3 Windows 2000 L)
192 1681002 X P DELFHIZ005 Windows XF 2
192, 16810020 MASTER HF
192 16210092 STEFAN indows
192 1621005 LUCIANP Mindows XP 2
192 16810053 MARKXP Windows XF 2

CATEGORY: Information

Wulnerability: & modem isinstalled on this computer—

Product: WA

Sewverity: MiA

Timestamp: 2002-01-01

Affected Hosts: IR0 = Host Hame Operating Swvstem S E
192 1658 10017B0GWXP Windows XF 2

Screenshot 66 — Sample report showing vulnerability listing by category

o Vulnerability details including name, description and severity

o List of host machines affected by each vulnerability detected

Use this report to:

o List detected vulnerabilities grouped by category, and the host
machines affected by each vulnerability.
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Vulnerability listing by host

Scan reference: 192,168,100, 2-192,165, 100,254
Scan date & time: 11/29/2006 10:12:254M

o * 182 162100414 - VSORIN-DZ005 240
Operating System:  Windaws XP o *

Service Pack: Gaold

Total Host wulmerabilities : 18 g
e * Total Metwork Volnerabilities: 303

Total Host s Total Metwork: 5.04%

e Category : Information
Product : M

Timestamp: WA

Sewerity: MR
Category : Registry
Product: M
Timestamp: 2002-01-01
Sewerity: Lo

Category : Registry

Froduct : A,
Timestamp: 2002-04-01
Sewerity: Lot

Category : Registry

Product : MeA
Timestamp: 2002-04-01
Sewerity: Lo

Category : Registny

Froduct : MR

Timestamp:  1999-05-07

Sewverity: Lov

Category : Registry

Product : M,

Timestamp: 2002-01-01

Sewerity: Lo
Marme: User ASPMET neverlogged on
Description: Itiz recommended to remowe this account if not wsed
Product :

Screenshot 67 — Sample report showing vulnerability listing by host

Host machine details on which vulnerabilities were detected

Vulnerability count for each host, also shown as a percentage of total
vulnerabilities detected on the network

List of vulnerability details for each host, including name, description and
severity

Chart displaying percentage of vulnerabilities detected on each host
compared to total vulnerabilities detected on the network

000e

Use this report to:

e List the vulnerabilities detected for each host machine on the
network.
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Vulnerability listing by product

192.168,100.2-192, 168,100,254
11/29/2006 10:12:254M

Scan reference:
Scan date & time:

o * FRODUCT:

“ulnerability:  Aconnection could be opened using accountAdministratorwithout pazword —

Cateqory : Senice

Sevverity: High

Timestamp: Hria

Affected Hosts : JIENEEE =S Host Hame Operating
192 165.10098 STEFAN Wind s

Wulnerability . A modem isinstalled on this computer—

Category : Information

Sevverity: MiA

Timestamp: 2002-01-01

Affected Hosts @ [[|EHEEE === Host Mame Operating Sy A
192 165 100AT0B D GWXP Windos 2P z

“ulmerability 1 Administrator account axiste—

Category : Inform ation

Severity: YTy

Timestamp: MiA

Affected Hosts: Host Mames

o * 192 165.1006 LUCIANP Windams 2P z

192168 .1002058/2054 Windons 2P 2
192.168.100.31 NSMZKISTD Windoms Sencer 2003 1
192 165 100240/ X FDELFHIZ005 Windos 2P z
192 1628 100 21 EVIRTUALZ Windams 2P 2
19216810054 MARKXF Windons 2P 2
192162 100Z3CHR3 Wind oz 2000 4
192 165 100235 &4 Windos 2P 1
192 165100230451 Wrind ows 2P 2
192.168.100.12 STELI Windone 2P G5 1
192 165.10066 FSERWVER Windoms Sener 2003 Gaold
192 168 100Z20TES TS TATION Windons Sener 2003 1
192 162 1004708 0 GWXP Mind o P 2
192.162.10075 MARK-TESTING Windone 2P G5 1
192.162.10075 MARK Windawms 2P 2
192.168.10024 HORI Windons 2P G 1
192.168.100. 119 SORIN-D2005 Wind s 2P Gold
192.162.10020 CALDEW Windams 2P z

Mams: User ASPNET neverlogged on
Description : ltizrecommended to remowe thiz account if not usad
Product :

Screenshot 68 — Sample report showing vulnerability listing by product

Name of product for which vulnerabilities were detected

2,

Vulnerability details for each product, including name, description and
severity

List of host machines affected by each product vulnerability detected

Use this report to:

List detected vulnerabilities grouped by product, and the host
machines affected by each vulnerability.
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Vulnerability listing by severity

Scan reference: 192,168.100,2-192, 168,100, 24
Scan date & bime:  11)29/2006 10:12:25A4M

“ulnersbility:  Aconnection could be opened using account Administrato rwith out paswod —
6 *Category: Sanice

Product : MR

Timestamp: MiA

Affected Hosts : [I5EElE == Host Hame Operating

192 162810099 STEFAN WWind owus

“ulnerability:  Application notup to date AdAumare SE Personal Editior—

Cateqory : Security ProduckE

Froduct : LR

Timestamp: I

Affected Hosts : [I50EEE =S Host Hame Operating

192.162.10020 CALDEY Windows XF 2

“ulnerability:  Application not up to date F-Prot Antivires for Wind ous—-

Cateqaory: Security ProduckE

Product : M

Timestamp: Nia

Affected Hosts : JIR0EEEEES Host Hame

192182 10064 MARKXP Windows XP 2

“ulmershbility: Alerterservice enablad—
Category Senvices
Product : M

Timestamp: 1997-12-01
Affected Hosts: JIENEEEC Host Name

9 * 192,162 1001555 ERVER Windaows 2000 Unkn own
192 168 10021 NEMZKZSTD Windowe Senrer 2003 1
1921621005 LUCIANP Windows xP 2
192,162 10017080 GWEP Windows xF 2
192162 100222CHR3 Windowves 2000 4
182162 10075 MARIK Windows XP 2

Screenshot 69 — Sample report showing vulnerability listing by severity

o Severity level

o Vulnerability details for each severity level, including name and description

o List of host machines affected by vulnerabilities detected for each security
level

Use this report to:

o List detected vulnerabilities grouped by severity, and the host
machines affected by each vulnerability.
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Open trojan ports by host

Open Port Listing by Host
This repont #haind 5 ket of Opash Pors foiind ofi &Bch Mot INE Sould darve 52 5 backdoor for 10| 5.

Created date  J1N12005 14:21:34

Scan reference filie: S arriphebborstL ish At
Scan dabe & binve 1 21/12)2005 1005858

Opserating Systern  'Wilindows P
o * Serdice Fack 1
Opser Port Court 3
PpsenPosts |
Dhrniriy Tresgan B O (500
e = Drumenvy Trojan &Y (1005)
Doy Trojan, B 5 55 (1038)

Opsar wtireg Systern  Wiindows XP
Service Pack: Uik ey
Open Port Court i

L
Dy Trean &Y Y (1005)
Doamirniy Trojan KBS, T (1 1238

Oparating Systeen  Windows Sarver 2003

D-Myfmj.h'l BLESS (1008
Doamirniy Tresjan, B1 O (500

Screenshot 70 — Sample report showing open trojan ports by cost

o Details of host machines having open ports associated with trojans

o List of open ports for each host and the names of trojans targeting each
port

Use this report to:

e List open ports, grouped by host machine, which could potentially
serve as a backdoor for trojans.

Open trojan ports

Top 20 Open Trojan Ports
This repost shows tha Topll medt comamen cpen trojan pomaboe kdeors) found on the Petuork

Cresed date 2171272005 14:24,10

Scan reference: file: Samphs Host Listod
Scan date & binee ;  D1ALG005 1005855

Dwrmﬂroj:n A'\"r ([06S) |
* Doarmariy Trojae . B. 555 (1006 ki
i

1

Diarmery Trojars. B0 (500
Doarmarriy Trojae X85, T (1134)

Screenshot 71 — Sample report showing open trojan ports
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o List showing the most common open trojan ports detected on the network

Use this report to:

e List the 20 most common open ports found on the network, which
could potentially serve as a backdoor for trojans.

Top SANS vulnerabilities status

Scan reference: 127.0.0.1
Scan date & time: Z3-Nov-Z006 15:37

(1

Operating Swystem Service Pack
Wiind oz XP 2

M=rme: AutoShareis
De=scription: The administrative shares CF,DF, ADMINE, 2 are available an this machine For
Product : Internal netwodes these are normally turned on for administrative pumposes. For Mieb

senvens) these are normally turned off in orderto salidify the possible entry poinksinee

itiz more exposed to attade). If wou don't use them set

HELME S TEMMC urre ntControl 5 etvS enviceshlanm anseretp araterme s otoShariiis
e * tolto prevent creation of these shares. Formore information, vist

http:fsup port.microsoft. co misup potkbs articl e 245MM 7 azp

MHare: Cached Logon Credentiak
Description : ficrosoftiindows MT cachesthe logon information of userswho would have logged on,
Product : sothattheywould be able to logonwhen the sernveris unavailable When a domain

controllerizunavailable and a user's logon infarmation iz cached, the userwill still be
allowyed to logon The cache can hold up fromd toS0 lagon attempts, with the value o0
disabling logon caching Ifthe value issetto a highwalue and an administratorlogsinto
computersto solwe specific problems, an attacker might obtain the credentiak of the
administrator at a laterstage, and logonwith such an account, having ponerdul
privileges. The registnyvalue forsetting thistype of caching
imHKEY_CURRENT_USERMS oftwareMicrozoftiifindowsH ThE urre nt e =i omiiinlogonld
eallyitshould be setto eitheld to disable caching, orelse itshould be settol to provide
foarfunctionality allowing the last userto logon immediately nesd ime) and security.

Marme: DCOM isenabled
Description : Distributed Component Object ModefDCOM) issimilarto Component Obje ot b odel
Product : (COM butitizdistributed acrossseveral nebwoted computersto communicate with

eachother, COM on Windowsd5 had no security, howewer, DCOM does, In order to
enable DCOM, EnableDCOM found in

HKEY_LOCAL_hACHINEVS ofhwareihdicrosoOLE registry kew, should be set ™",
Thiswould enhance the systemis security features.

LEIER Lastlogged-on usarname wisible

Description: By default, NT.2k displays the last loggedon user Formore information, wisit
Product ; http:fsupport.microsoft. co misup potkbsarticlesiq 11449453 a=p

M=rme: LM Hash

Description: ltizrecommendedto use NTLM authentication irsbead of LM Formore information,
Froduct ; wizsit hitpifsupportmicrosoft.comsupporthblaiclesq 1477 05 azp

MNarme : Aoconnection could be opened using account Administratorwithout paswond!
Description : “rou UST set a pasaword forthe administrator aceount andfordisable guest logons
Product :

MNarme : Administrator account exiss

Description : ltizsrecommended to rename this acoourt

Product :

Hame: User ASPMHET neverlogged on

Description: tisrecammendedto remowe this account if not used

Product

Screenshot 72 — Sample report showing top SANS vulnerabilities status

o Host machine details on which vulnerabilities reported by SANS were
detected

o List showing SANS vulnerability details, including name, description and
product affected. SANS vulnerabilities are grouped by year and chapter

Use this report to:

e List the vulnerabilities detected for each host machine, based on
the SANS top-20 report of vulnerabilities.
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Vulnerable hosts based on open ports

Top 20 Most Vulnerable Hosts(by Open Ports)

This report shows the Top2D most wilnarable bosts based onthe numbsrof opssh trojan port shackdoors]) founs
o adch maching

Crested dse 207122008 143807

Scan reference fily; Sample Howt List
Scan date & bimve 1 21005 105955

IF Adidress Hiaet Nune Opsesr stirigy Systemm Saru. Pack 0 Parts

192,188 20,35  KelthTen Whnedouws XP 2 3
o * 192,180 2040 Keithisdain ‘wndows XP Uk rigemn |

192 168 25,10 KesthServerZi3 ‘Windows Server DG 1 1

Screenshot 73 — Sample report showing vulnerable hosts based on open ports

o List showing the top 20 host machines most likely to be compromised by
trojans

Use this report to:

e List the 20 most vulnerable host machines, based on the number
of open trojan ports found.

Vulnerable hosts based on vulnerability level

Scan reference ¢ B0.143.32.1/24
Scan date & time : 05-Feb-2007 13:04

| Top 20 hosts based on Vulnerability Level

Missing Patehes

Imprt.  Moder.
o* EJ::D211 B High Windows 2000 4 24 10 & 2 78 35 £l o o
ig.;:a.az 8 W Hih Windaws 3P 1 13 1 7 &1 = 0 1 2
_3:;‘;332221 | Windows XP Gold 12 3 1 B a1 a 7 K 0
S;“:a'a: 140 B in Windaowes ¥P 2 2 2 1 &0 2 z g 3
LSRR O wich Windows P 2 e 2 1 s 1 1 [} (] o
g0z [ Medium Windows XP 2 [ 0 1 5 o o 0 0 o
;2;::3.1D2.17B O Low PP a 5 o o 5 ] o [ o o

Screenshot 74 — Sample report showing vulnerable hosts based on vulnerability level

o Host machine details showing the number of vulnerabilities and missing
patches detected according to criticality

Use this report to:

e List the 20 most vulnerable host machines for each network
security scan, based on vulnerability level.
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Patch management reports

Network patching status

Scan reference: 192,168,100,2-192,168, 100,24
Scan date & time: Z9-Nov-Z006 10:12

And Installed Patch

B Installad
B Mis=ing

crlkz= mporEnl L= g1 Lows orers

Total=
Critical Importart
Installed
Mizsing 153 179 &3 & 44
Total=s BEE =D 35T 125 11 S

W Installed 23

W hissing 17
Total: 40

Screenshot 75 — Sample report showing network patching status

Chart displaying the number of installed and missing patches, grouped by
severity

o Chart displaying the number of installed and missing service packs
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Il SOG-006 Security Update farufindowes Media Player Plug-in (KB311550 2006-02-14

Mot Aorailable  Windows balicious Software Remowal Tool - July 2006 (<B2202300 2005-07-11
Mot Available MDAC 2.8 Senvice Padk 1 2006-02-01
ht S04-043 Security Update forifindoves 2P (KBE7T 3335 2004-12-15
b SO0 Security Update for Wfind oves 2P (KB2E525) 2005-04-12
hd S0<3-0<H Security Update forifindoves XF (KBSS5S35) 2004-12-15
hd S05-015 Security Update forifind oves XF (KBSS2113) 2005-02-08
h S05-00F Security Update foriindoves 2P (KB222302) 2005-02-02
W S05-032 Security Update forifind oves 2P (KB290045) 2005-08-10
M S05-012 Security Update forWfindoves 2P (KB2902520 2005-07-26

[ Host Name I :

192.168. 100235 MG 25 1] 30 =] 1 T
192,168, 100232 CB2 2 0 28 7 u] =]
192.168.10065 FSERWER 21 1 23 13 1 5]
192.168.10075 MARK 16 1 21 =] 1 3
192,168, 1006 LUCIANP 16 1 15 4] 1 2
192,168, 100205 V2064 16 1] 21 5 1 z
192.1658.10020 CALDEW 14 a 20 7 1 5
192,168 100220 TESTSTATION 12 1] 13 2 u] 1
192,168, 100114 WS ORIN-D2005 10 1] 7 3 1] 19
192,165 10024 HORI 1 0 u] u] u] u]
192.168.10031 HNSM2KISTD 1] 1 u] u] u] u]
192.162.10013 STELI 1] 1] u] 1 u] u]
192,168,100 211 ZVIRTUALZ a a a a a 1
192,168 10024 WV PDELPHIZ005 u] u] u] u] u] 1
192,168, 100232 MG 1] 1] n] n] n] 1
192,168 10063 MARKEP 0 0 u] u] u] 1
192.168.10045 FROJECT 1] 1] u] u] u] u]
192.168.10017 BOBBY 1] 1] u] u] u] u]
192.168.10019 HSh_XP2E4 a a a a a a
192.168.10023 MASTERSERW u] u] u] u] u] u]

Screenshot 76 — Sample report showing network patching status

o List showing the top 10 missing security updates

List showing the top 20 most vulnerable host machines, as a result of
o missing patches and service packs. The number of vulnerabilities detected
is split according to severity

Use this report to:

o lllustrate the status of patches and service packs for host
machines on the network.
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Missing patches grouped by host

(1 L

(213

Screenshot 77 — Sample report showing missing patches grouped by host

Scan reference: 192,165,100.2-192, 165,100,254
Scan date & time:  29-Mov-2006 10012

0.11

Mind o P

Gold i ]

Operating System Service Pack Patch Count

Eulletin 1D
Mot forailable

Mot Aorailable
h 50032
S04 045

Mot Available
M502-051
MS03-012

ME04-04 1
ME04-015
ME09-037
ME04-00

MES04-023
ME09-02g
M S09-025
ME0g-02
M S09-031
MS09-035

MS04-0.20
ME0S-029
M S0E-051
ME0A-045
SO0
ME0A042
M S03-00E

ME02-042
ME02-095
ME0Z-042
MES02-002
MS02-080
MS03-0441
MES02-049
M S02-005
MS0E-020
hE0E-029
MS02-028
ME02-022

ME02-012
ME0Z-017
ME01-050

indows b alicious Sofhware Remawal Took July 2006
[(KES20530

Windows P Senvice Padi2

Security Update for'iind ows 2P (KBS0
Cumulative Security Update for Qutlook Expres=s SP1
[KESZ23353

Update Rollup 1 for bicrosoft viindows <P (KBS2 2520
QE24380: Security Upd ate (ind awe XF)

Q21111% Security UpdateQWindows 2P or Windows X
Semice Pack1)

Security Update for'Wind ows 2P (KBE35732)

Security Update for'ffind oms P (KB2S03TE

Security Update for'find ones XP (KB2G13255)
Security Update for Microsoft 0 ata Accesz Components
[KES324583

Security Update forlind oms 2P (KB2403215)

Security Update for'ffind ons XP (KB23253T

Security Update for'lind ons <P (KBS3335T)

Security Update for'ffind coms P (KB2S127Z

Security Update for'find ows 2P (KBS31533)
Cumulative Security Update forInternet ExploreS Service Pack
1 (KB224T0N

Security Update forlind owns AP (KB224151)

Security Update for'find ovs 2P (KBS 3376

Security Update for'lind ows 2P (KBS10217)

Security Update for'iind ows 2P (KBE395433)

Security Update for'find oves 2P (KBE37001)

Security Update for'iind ows 2P (KBEZ37H)

814078 Security Update!Microsoft Jscript version 55, Windons
2000, Wiind owes 2P

Security Update for bicrasoft nindows <P (KBS22035)
QEZE830: Security Upd ate (ind awe XF)

Q323172: Security Update (0'ind owe 2F)

Security Update, Februane 13, 2002 (M SXMML 25)
Security Update for bicrosoft Windows XP (KB232223490
Security Update for bicrosoft Windows (KB222122)
Security Update for bicrosoft Windows XP (KBE25119)
Security Update, Februany 13, 2002 (hd SXWiL 400
Security Update for'ind oves 2P (2819656)

Security Update for bicrasoft ind o (KBE24105)
Q318138 Security Update (ind awe <F)

Q20920 Security Update®tindowes Media Player foriindows
pA

D?13450:5ecurit5rUpdate

Q211857 : Security Update

Security Update, December 17, 2001

2006-07-14

2006-04-25
2008-04-12
2008-04-11

2005-04-12
2005-03-25
2005-032-25

2005-02-19
2005-02-19
2005-02-17
2005-02-17

2005-02-12
2005-02-02
2004-12-15
2004-12-15
2004-11-20
2004-11-20

2004-11-20
2004-11-20
20041004
2004-07-256
2004-07-22
2004-07-06
2003-11-21

200:3-11-20
2003-11-14
2003-11-14
2003-10-21
2003-10-16
2003-10-12
2003-10-12
2003-09-30
2003-09-16
2003-09-02
2003-05-05
200:3-05-12

200:3-02-12
2003-02-18
2003-02-12

MNiA

KA
Critical
tdoderate

MiA
foderate
Important

Critical
Important
Critical
Important

Critical
Important
Critical
Critical
Impartarnt
Critical

Impartant
Critical
Critical

tdoderate

Impartarnt
Critical

MiA

NIA
NiA
NIA
NI
NiA
NI
NI
NI
MNIA
NI
NI
NIA

NIA
KA
MNA

Host machine details on which missing patches were detected

2,

List of missing patch details for each host, including severity and URL link
for further information

Use this report to:

e List missing patches grouped by host machine, including URL links
providing further information on each missing patch.
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Missing patches grouped by operating system

Scan reference: 192.1658,100.2-192. 168, 100,254
Scan date & time:  29-Now-2006 10:12

o *Pa‘:ch: 9143283 EBulletin 1D: W S05-025 Fosted Date: 2005-07-11 Sewverity: Critical
Description: Security Update foriind owes 2000 (B9 13333
Host Hare
192168100238 CB3 4
Patch: 220820 Bulletim ID: MotAwailable Posted Date: 2005-07-11 Senverity: NA
Description: Windoms Malicious Sofhuare Remowal Tool - July 2006 (KB2202300
Hos=t IF Host Name g
192162100232 cB2 <4
Patch: 917344 Bulletin 1D: WES0G5-023 FPosted Date : 2005-06-13 Senverity: Modarate
Description: Security Update forfindows Server2003 (KBD 17250
Host Name E
e 192,165, 100220 TESTSTATION 1
19216810055 FSERWER Gold

Screenshot 78 — Sample report showing missing patches grouped by operating system

o Missing patch details for each operating system

o List of host machines on which specific patches were found to be missing

Use this report to:

e List missing patches grouped by operating system, including the
host machine names for each missing patch.

Missing patches grouped by severity

Scan reference: 192,168,100,2-192,168, 100, 2%
Scan date & time: Z9-Nov-Z006 10:12

Critical

o Fatch: 917158 Bulletin ID: MSDB-025  Fosted Date : 2008-07-11
Description: Security Update forWindows Server 2003 (KBI17129
Host IP Host Hame Operating &
192462 10020 TESTSTATION Windows Senrer2002 1
Patoh: 914358 Eulletin 10: MS0G-035 Posted Date: 2005-07-11
Description: Security Update forifindowms Server 2003 (KB3145333)
Ho=t IF Host Hame Operating
192 168 100220 TESTSTATION Windows Senrer2003 1
Patch: 914358 Bulletin 10: MS0S-025 Posted Oate: 2005-07-11
Description: Security Update forutind auws XP (KBS 52255
Ho=t IF Host Hare Operating Sy
189216810075 AR Windows P 2
Patch: 917159 Bulletin 1D b S05-035 Posted Date: 2006-07-11
Description: Security Update foriind ams XP (KB217 192
Host Hare Operatin N
e 19216510075 [T iind aws P 2
1926800225 Tl G4 Wfind ows XP 1

Screenshot 79 — Sample report showing missing patches grouped by severity
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Missing patch details for each severity level

2]

List of host machines on which specific patches were found to be missing

Use this report to:

e List missing patches grouped by severity, including the host
machine names for each missing patch.

Installed patches grouped by host

Scan reference:
Scan date & time:

192.165,100.2-192,168, 100,254
29-Mow-2006 10:12

o * 0E- LUCIANFP
Operating System Service Pack  Patch Count
Windows XP 2 17
Bulletin ID iption *osted Date
R S0G-005 Security Update forindowns Media Played 2005-02-14
e * ‘KBS 11555
Mot Awailable  WDAC 2.2 Semice Pack 1 2006-02-01
h=05-015 Security Update forWiindoms XF (KBS90259) 2005-07-25
b 504043 Security Update forWiindows XF (KBS25520) 2005-04- 13
MS05-020 Cumulative Security Update for Intern et Explomerfor  2005-04-12
indans XP Sernvice Pack (HKE3E0923)

ME0S-016 Security Update for Wiindows XP (KBE930E5) 2005-04-12
ME05-011 Security Update foriiindoms XP (KBES5250) 2005-02-23
hA505-007 Security Update forWiindos XF (KBS2830E) 2005-02-02
MES0S5-009 Security Update for Windowes Messenger(KB387 2  2005-02-03
ME0S5-012 Security Upd ate forWindomas XP (KBET322) 2005-02-02
ME0S-015 Security Upd ate forWindomas XP (KBE22113) 2005-02-02
ME05-012 Security Update foriiindmus XF (KBE91781) 2005-02-08
ME05-004 Security Update foriindmus XP (KBES0175) 2005-01-18
MEDG-042 Security Update foriindmas XP (KBET 22200 2009-12-15
S04 044 Security Update foriindmes XP (BE25ET) 20049-12-15
MotAvailable  Microsoft NET Framewor 1.1 Senvice Padcl 2004-09-01
03011 609 Security Update Microsoftirtu al b achine 20040502

“hlicrosoft Wik

¢ Unintzllable

Critical

High
Important
Important

Critical

Impartant
Critical
Important
hloderate
Important
Important
Impaortant
Critical
Important
Important
MR
Critical

Mo

Mo
ez
ez
e

ez
ez
ez
e
e
ez
ez
es
“fes
Mo
Mo

Screenshot 80 — Sample report showing installed patches grouped by host

Host machine details on which installed patches were detected

2]

List of installed patch details for each host, including severity, URL link for
further information and indication if the patch can be uninstalled

Use this report to:

e List installed patches grouped by host machine, including URL
links providing further information on each installed patch.

Installed patches grouped by operating system

Scan reference:
Scan date & time:

192.168,100.2-192, 165,100,254
29-Mow-2006 10012

o *Patch: s2g101

Sewerity  Miw

Bulletin I Mot Awvailable
Uninstallable: Mo
Description: Windows Server 2003 Service Pack

FPosted Date 2006-07-11

Host IP

192 62 10020

e *192.158.10031

Hos=t Narme
TESTSTATION
NEM2KISTDR

Patch: 890330
Sewerity  NiA

Bulletin |0; Mot Awailable
Uninstallable: Mo

Description: Windowes Malicious Sofhware Remowval Taaol - July 2006 {RESE0EED

FPosted Date 2005-07-11

192 163 10031

Hos=t Narme
NSMZKISTD

74 e Appendix: GFI LANguard Network Security Scanner default reports

GFI ReportCenter



Screenshot 81 — Sample report showing installed patches grouped by operating system

o Installed patch details for each operating system

o List of host machines on which specific patches were found to be installed

Use this report to:

e List installed patches grouped by operating system, including the
host machine names for each installed patch.

Installed patches grouped by severity

Scan reference: 192,165,100.2-192, 165,100,254
Scan date & time:  29-MNow-2006 10:12

o *Pa{ch: 889455 Bulletin 10: HNot Awvailable Fosted Date 2005-02-01

Uninstallable: No
De=scription: MDAC 2.2 Senvice Pack 1

Host Hame Operzting System

19216810012 STELI Windows XF 54 1
192 162 10064 MAREXP Windows XP 2
e *192.168.10024? WAPDELPHI2O0G Windows XP 2
192 16210024 HORI Windows XP »54 1
192 162,100,170 BOGWEP Windows xP 2
192168 . 10020 CALDEY Windows XP 2
192168 10075 MARK Windows XP 2

Screenshot 82 — Sample report showing installed patches grouped by severity

o List of installed patches grouped by their severity level, including
information on each patch

o List of host machines on which specific patches were found to be installed

Use this report to:

e List installed patches grouped by severity, including the host
machine names for each installed patch.

Deployment history by host

[ate Started [ate Ended Completed Stats Type Iz Scheduled
1420020068 2:45:25PM 1152002006 2:45:52PM  With errors. Custom Mo

e * Files:  AnotherFile. exe config
[ ate Started [rate Ended Completed Stats Type I=5cheduled
1152002006 2:496:83PM 112002006 2:47:05PM  Succestully. Custam Na

Filaz: HNOTEPAD.EXE;

Screenshot 83 — Sample report showing deployment history by host

o Host machine on which deployments were made

o List of deployment details for each host, including file hames deployed,
and deployment status

Use this report to:

o Display patch deployment information grouped by host machine,
including deployment details such as date and status.
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Deployment history by date

24526FM

Target [rate Ended Completed Stabs Type Iz Scheduled
192, 162,100,199 112002008 2:45:52PM  With ermors. Custom No

* Files: AnotherFile.exe config

Target [rate Ended Completed Stabus Type Iz Scheduled
TestHost2 1172002006 2:45:52FM Erroneous. Custom Mo

Files: outbdd; T29 b vsswer.soo;

Screenshot 84 — Sample report showing deployment history by date

o Deployment starting date

o List of deployment details grouped by host, including file names deployed,
and deployment status

Use this report to:

o Display patch deployment information by date and time, including
details such as host machine names for each deployment.

Deployment history by patch

leploymernts
[rate Started Late Ended Completed Stahes Type Iz Scheduled
112002006 2:45:26Ph 14/2002006 2:45:52FPM  With emrors. Custom Mo

* Target: 1921621001492

Screenshot 85 — Sample report showing deployment history by patch

o Name of patch deployed

o List of host machines on which the patch was deployed and deployment
details, including deployment status

Use this report to:

e Display patch deployment information grouped by patch applied,
including details such as host machine names for each
deployment.
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System information reports

Software audit

Scan reference ; 80.143.32.1/24
Scan date & time : 2/3/2007  2:30:23FM

Top 10 Systems with Unauthorized Applications
o * F Host Name: Unauthorized A

B50.143.32 211 Andrew 2
£0.143.32.233 Andy 1

Top 10 Unauthorized Applications

Systems with Security Applicafions

e Systerns Without SYSSCEITEH;-‘IM
Any Securty curty

Application Applcations Mot
Updated

!
r

BLON sems
Systerns With Secunity Applicatons Mot Updated 1
Systerms Without Any Security Application 1

Top 20 Most Installed Applications

Cicourance 2
= Host Name Dperating System
BD.143.32.211 Andrew Windows 2000
BD.14332.233 Andy Windows XP

Publisher : Wiware, Inz.
1

]
8
£
[}
]

i
|
5

Host Name Operating System

Publisher : Wiware, Inz.

Cioourance 1
= Host Name Dperating System
ED.143.22211 Andrew Windows 2000

Screenshot 86 — Sample report showing software audit

List showing the top 10 host machines with unauthorized applications

List showing the top 10 unauthorized applications

Chart displaying the status of security applications on host machines

List showing the top 20 installed applications

0000

Use this report to:

e |dentify unauthorized applications installed on host machines,
detected during network security scans
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¢ Identify the top 10 host machines with unauthorized applications

¢ Identify the top 10 unauthorized applications with highest number
of installations

¢ Identify the top 20 installed applications

e Graphically represent the number of host machines without
security applications, or with security applications not updated.

Operating system and service pack distribution

Dperating System and Service Pack Distribution
A graphical and textual representation of operating sy stem distributions together with their related service packs.

Cremed date 21/2/2005 141020

Scan reference: Fila 1S amplaFHostlist bat
Scan dabe & bime 1 210122005 10:58:55

Opersling Systern distribusor

Whedowi P Joikvoma] .
Wlndow s 2000 | w parkreowng Sl
B Vilrelow 5 2000 %
o* o Vilrsdow 1 Sepeer 2000 &0 0%
Wil 1 0P X%
Tolal 100 0%

Whidom 8 e 1 2000

[urknown] 1
Windows J000 1
Windows Server 2003 B
Windows XP F'i

Service Pack distribution

Serules Pack Number o Haozlz
Jurkncan] [uniknawn ] 1
o*.unmau 2000 Gald 1
Wiindows Senver 2003 2
Wiindows Server 2003 1 2
Wiindows Senver 2003 Gald 2
Wi owz XP 1
Windows KP 2 1

Screenshot 87 — Sample report showing operating system and service pack distribution
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Chart displaying distribution percentage of each operating system on the
network

List of operating systems, including the number of host machines on which
they are installed

Chart displaying service pack distribution for each operating system

List of operating system service packs, including the number of host
machines on which they are installed

000 e

Use this report to:
e Graphically represent operating systems detected on the network
o List the number of host machines for each operating system

e Graphically represent service packs detected on the network for
each operating system

e List the number of host machines for each service pack installed.
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System information

Scan reference: File:lisk. bk
Scan date & time: 1/3/2007 2:33:16FM

Operating System Service Pack
Wind o <P 2

MALC Address 000E-0C-3C-A3-361(Intel Corparation
Time to lwe 128 0128)

MNetmok role  Wodstation

Camaire WORKEEROUP

LAN manager  Windows 2000 LAN Manager

y Up Ti m=
22 2 zeconds, 321 m=
S 653 ms

il Total E:pa.:: ]
C: 242424 FAT 22

Marme
Administrators Administrators have complete and unrestricted accessto the
computerdomain
tdembers: MARKALNESS_MOMITOR_USR, MAR K root, WAR KW minisiator
Guests Guests hawve thesame aceess as members of the Usars group by
default, exceptforthe Guest account which isfurth er restriced
Members: MARKwba_anonymous, AR KRGt
Users Users are preventad from making accidental orintentional
system-wide changes Thus, Userscan run certified applications,
but not most legacy applicatons
tembers NT AUTHORITYINTERACTIVE, NT AUTHORITYWuthenticated Users, MARKWIPNET,
hdAR A mtest, AR Koot

Help Services Group zroup forthe Help and Support Center
Members: MAREMSUPPORT 38399540
W ITIVENE Whivare User Group

fembers: MARKL__ wmuare_user

Adrinistraton)
Frivilege: Administrator(™
Flags: SCRIPT HORMAL_ACCOUNT
Comment: Builtin accountfor administering the computeddomain
LastLogon: 28 Now2005, 15:44 55
FasamordAge : 19 days, , 30 minutes, 16 seconds
# Logons: 2,229
BadFasamwordCount: 4

Screenshot 88 — Sample report showing system information

Host machine IP and name

Host machine details, including MAC address and domain

Uptime details for each host machine, including time of day and uptime
value

Disk utilization details for each host machine, including drive name, file
system type, total storage space and free storage space

Group and user details for each host machine, including group name,
group members, user privileges and user bad password count

00000
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RELIE iption

Object_ID 1.3.6.1.41.311.1.1.3.1.3(NT Domain Contolle)

syshescr Hardware: 36 Family 15 Model 4 Stepping 1 ATMAT COMPATI
sysHame FROJECT

sysUpTime 18 minutes, 45 seconds

Wendaor icrosoft

Senvice Mame Status Startup Type AccountMame

Alerter Funning  Automatic NT AUTHORITiLocalSemice
LG

Semice Name Status Startup Type AccountMame

Application Layer &ateway S enice Running  Manual NT AUTHORIT W Localsewic:
oo bMgmit

Senvice Mame Status Startup Type AccountMame

Application b anagement Stopped  Manual LocalSystem

Senvice Name Status Startup Type AccountMame

ASP.HET State Senvice Stopped  Manual NT AUTHORITvWHetwodeS e nvice
Senvice Mame Status Startup Type AccountMame

Mind o Audia Funning  Automatic LocalSystem

Sernvice Mame Status Startup Type AccountMame

Badkiground Intelligent Transfer S enic: Stopped  Manual LocalSystem

Senvice Mame Status Startup Type AccountMame

Computer Browser Funning  Automatic LocalSystem

PFID : 1045

Uszer Mame: LOCAL SERWICE
Domain: NT AUTHORITY
Handle Count 107

Thread Count &

Friority: &

FID: 2236

PPID : 2072

Uszer Mame: Administrator

Fath - CAWINDOW Shsyste ma32atiptasc exe

Lomain: MARIK

Command Line: "COWINDO0WShayste m32hati ptaod exd'
Handle Count 53

Thread Count 1

Friority: 2

Screenshot 89 — Sample report showing system information

SNMP details for each host machine, including name and description

Service details for each host machine, including name, description, status,
startup type and account name

Process details for each host machine, including process ID and account
name

©00
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USE Root Hub

Description UZB Root Hub

hanufacturer: (Standard USB Host Contralled
LUSE Root Hub

Description U5SB Root Hub

hanufacturer (Standard USH Host Contralled
USE Root Hub

Description IUSH Raoot Hub

lanufacturer (Standard USB Host Controllen

There were no Blacklisted USE Dewvices wulnerabilities deteded

WAN Miniport [L2TP]

OHCP Set: Falze

WAN Miniport (FPTF)

hAC Address: 50:50:54:50:30:20
DHCP Set: False

WA KMiniport (PRPOE)

hdAC Address: 33:6006F 452020
OHCP Set: Falze

There wereno Blacklisted Wireless Devices wulnerabilities dabected

e Remark
ADMING Remote Admin
- share
CH Defaultshare
CD Drive (F) Mrs
L share
DF Defaultzhare
E share
EF Defaultshare
IPCE Remote IPC
XP Prof- SP2- WAPGE MR

m * Open Ports

3592 [ Full Port Lisf
207 [ Full Port Lisg
2405 Full Port Lisg
2 03[ Full Port Lisg
1,801[Full Part List]
139 [Hetbiosssn=> NETBIOS Session Senvice]

LD Forts

1,900 ([ Full Port Lisg
1,942 [ Full Port Lisg
128 [Full Port List]

Screenshot 90 — Sample report showing system information

List showing USB devices, blacklisted USB devices, network cards and
black listed wireless devices

Share folder details for each host machine, including name and remarks

Open port details for each host machine, including port number and name

060
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“pplication Namme Publi sher

Ad-Auvare SE Personal Edition Lawvasoft 1.06

Adobe Flash Playerd Actine Adobe Systems g
Adobe Reader7.02 Adobe Systems Incorporated F.O%8

ATIDisplay Driver
CCleanariremowe onhi
F-Frot Antiviras for'viind aws

Gadwin PrintScreen Gadwin Systems, Ine. 35
#FlEventstdanager? Report Pack 3F| Sofhware Ltd 1.0.2006 0207
EFl LANguard Network Security Seanner20 ZF| 8.0
GFIReport Canter Fram ewmork F| Sofhmare 2.5

3 Pukblisher
Aud-favare SE Personal Edition Lavasoft
Adobe Flash Player3 Actives Adobe Systemns a

ATIDisplay Criver
CCleaneriremove onhi
G adwin PrintScreen Gadwmin Systems, Inec. 3.5

0 chars 42 days, 22 hours, 47 no delay newer fopeme no histany
minutes, 21seconds

xurity Audit Policy
Audit account logon ewents True True
Audit aceount management True True
Audit directory senvice aocess False False
Auditlogon evenk True True
Auditobject acces Falze False
Audit policy change True True
Audit privilege use True True
Audit processtracking True True
Audit swstemn evants True True

@* Reqgistry Infor mation

~hHz : 2793

CSDWersion : Semice Pack?
CurrentBuildMumber : 2500

CurrentType : Multiprocessor Free
CurrentWersion : 5.1

[Default: 0400

Driverlesc: Media Control D evices
Driverbesc : RAGE XL PCI

Identifier: 85 Family 15 Model 4 Stepping 3

Fun ATIPTA : atiptasesse

Run FRISK FP-Scheduler: CAProgram
Files\F SIFProtF- Schedexe STARTUR

Fun F-Stopi: C:AProgram FilesiF SIVF-ProtiF-Stoplid. EXE

Run Intel Semerbanager CAprogram
filestintehServarhlanagensena fbinlem exe

Fun ISUSFM: "CAFrogram Files\Comman
Files\installShieldiWpdate SenicelSUSPM exe" =cheduler

Run M=malntCert: regsvi32 /= mqrt.dll

Run FROHokgrnfired: C:AProgram

Files\inte\PROSetifire ANCSV\PROS e PRONoMgr exe

Screenshot 91 — Sample report showing system information

@ Installed application details for each host machine, including name,
publisher and version

@ List showing password policy details security audit policy details

@ List of registry entry details for each host machine

Use this report to:

e List detailed technical information for each host machine, including
services, installed applications, policies and devices.
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Computer properties

Scan reference: 192,168.100,2-192, 165,100,254
Scan date & time; 1172972006 10:12:25AM

CATEGORY: FTF

Scan reference: 192.165.100.2-192. 165, 100. 2
Scan date & time: 29-MNov-2006 10:11

MALC Address O00F-EA-FO-FF-1EMGigaByte Technology Co, LT

e* Timetolve 1250128

Netwod rolee HAA
Domair HiA,
LAN manager  H/A

19216510012- [EOGDAN]

MALC Address 0014 DE90- BATC (ASUSTek Computerinc)
Time to lve 128128

Networ role MiA

Domair MR

LM manager HAA

Screenshot 92 — Sample report showing computer properties

o Host machine IP and name

o Host machine details, including MAC address and domain

Use this report to:

e List information for each host machine, including MAC address,
network role and domain.

Uptimes

Scan reference: 127.0.0.1
Scan date & time:  28-Movw-2006 15:37

Operating System Service Pack
Windowves XF 2
Up Time
e 0o 100 ms
23 123 ms

156 1 hours, 13 minutes, 2 seconds, 735 ms

192.168100.26- CB

Operating System Service Pack
Windowes Sener2003

ime of Day

4 41 ms

Screenshot 93 — Sample report showing uptimes

o Host machine IP and name

o Uptime details for each host machine, including time of day and uptime
value

Use this report to:
o List uptime for each host machine, grouped by network scan.
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Disk utilization

Scan reference: 127.0.0.1
Scan date & time: 25-Nov-2006 1537

(1 L

Operating System Serwvice Pack

Windowes XFP 2

Name Total Space ; ] =m Type
e*c: 6263662 NTFS

D 433423423 NTFS

Screenshot 94 — Sample report showing disk utilization

o Host machine IP and name

o Disk utilization details for each host machine, including drive name, file
system type, total storage space and free storage space

Use this report to:
e List disk utilization information for each host machine, including file

system type, total space and free space.
Groups and users

Scan reference: 192,1658,100.2-192, 168,100,254
Scan date & time:  29-Mov-2006 10:12

(1 2

Operating Systemn Service Pack
Windows XP 2

_ WIWERE “Whiiware Lzer Group
Members: LUCIANPY_ wmwware_user_
e * 192,168 .100.6 Admins 192,168 .100.6 Admins- Members can create and manage iiskbs
embers: BUILTINWdministratos
Adrinistrators Administrators have complete and unrestricted accessto the

computeddomain
Members: DEVELOFMENT \Domain Admins, LUCIANPWser, LUCIANPWdministrator, LU CIANFraok

Debugger U=sars Debuggerusers can debug processes on thismachine, both
locally and remotehy

Members: LUCIANPWUser

Guests izuests hawe thesame access as members of the Users group by
default, exceptforthe Guest accountwhich isfurth er restrided
hembers: LUCIANPUUSE_LUCIANF, LUCLANPWG uest

HelpServices Grogp Group farthe Help and Suppaort Certer
Members: LUCIANPYSURPPORT 28234530
Users Users are preventad from making accidental arintentional

system-wide changes Thus, Users can run cerified applications,
butnot mestlegacy applicatons
hembers DEVELOFPMENTA\Damain Users, NT AUTHORITWINTERACTIVE, NT AUTHORIT v Authenticated
Users, LUCLANPUWSPNET, LUCLAN o b, LUCLANPUACT Usar, LUCLANPAVS QL Debugger

e * Full Hame: Application Center Test Acount
Frivilege: User
Flags: SCRIPT,PASSWORD_CAMNOT_BE_CHAMGED MORMAL_ACCOUNT
Comment: Accountusedto launchthe Application Center Test Broker and Controllersemices
LastLogon: 14 Aug 2005, 163253
FasamardAge : 1068 days, 17 hours, 38 minutes, 45 seconds
# Logons: 3

Screenshot 95 — Sample report showing groups and users

Host machine IP and name

List showing group details for each host machine, including name,
description and members

©e

List of user details for each group, including user name, privilege, last
logon and bad password count
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Use this report to:
e List group and user information for each host machine.

SNMP information

Scan reference: 192.165,100,2-192, 165,100, 234
Scan date & time: 29-Mov-2006 10:11

10,17 - BOBBY
Operating System Service Pack
Wind cws XP
Description
Object_IC 1.2.6.1.4.1.211.1.1.2.1.1 (NT Wodestation)
e *s;rsDescr Hardweare: =86 Family 15 Model 3 Stepping 3 AT/AT COMPATI
sysMame BOBEY
sysUpTime 52 minutes, 23 seconds
“Wendor Microsoft

Screenshot 96 — Sample report showing SNMP information

o Host machine IP and name

o SNMP details for each host machine, including name and description

Use this report to:

o List SNMP information for each host machine, including name,
description and uptime.

Services

Scan reference: 192,1658,100,2-192,1658,100.2
Scan date & time: 29-Mow-2006 10011

o o | 1005 - LUCIANF

Operating System Service Pack
Wiindowes 2P 2

Blerter
e * Semice Mame Status Startup Type AccountMame
Alerter Running  Automatic HT AUTHORIT\LacalSenics
LG
Semice Mame Status Startup Type AccountMame
Application Layer G atevuay 5 enice Running  Manual MT AUTHORIT\LocalSenice
“op kMg mt
Senice Name Status Startup Type AccountMame
Application M anagement Stopped  Manual LacalSystem
spnet_state
Semice Mame Status Startup Type AccountMame
ASP.NET State Senvice Stopped  Manual MT AUTHORIT M etmo kS e i ce

Screenshot 97 — Sample report showing services

0 Host machine IP and name

o Service details for each host machine, including name, description, status,
startup type and account hame

Use this report to:

e List service information for each host machine, including
description, status, startup type and account name.
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Processes

Scan reference: 192,1658,100,2-192.168, 100,254
Scan date & time: Z9-Nov-2006 10012

(1 BY

0.114

Operating System Service Pack
Win dowes XP Zold

e * FID: 4
User Mame: 55 TEM

Domain: NT AUTHORITY
Handle Coont 640
Thread Count 49

Friority: &
FID: 208
FPID: 1216

User Mame: 555 TEM

Fath: CAProgram FilessCommon Filesshicrosoft SharediS70eb ughmdm.exe

Domain: MT AUTHORITY

Command Line: "CAProgram FileswCommon Filesibdicrozoft ShaedWS Cre bughmdm esxe”
Handle Count 70

Thread Count 4

Friority: 2

Screenshot 98 — Sample report showing processes

o Host machine IP and name

o Process details for each host machine, including process ID and account
name

Use this report to:
e List process properties for each host machine.
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Devices

Scan reference: 192,168.100,2-192.165. 100,24
Scan date & time: 29-Now-2006 10:12

o * 192.168.100.114- !
Operating System Service Pack
Wind o P zold

e * USE Devices
USE Root Hub
Descrption USH Root Hub
hwianufacturer (Standard USB Host Controllen

e * There were no Blacklisted USE Devices wulnerabilities detected

Hetwior k Dewvices
(4L

FPacket Scheduler Miniport

MAC Address: O0:0C:29: 104307
OHCP Set: Falze

Status: Plugged in

WAN Miniport [LZTP)

DHCP Set: False

Status: Flugged in

RAS Async Adapter

DOHCF Set: Falze

Status: Plugged in

AbAD PCHET Family PCI| Ethernet Adapter - Packet Sched

hAC Address: 00:0C:20:10:A3:07

IP Addresaes): 192.168.100.114, 192 168.18 .29, 192 1628 15821, 192 16E
Hostname WSarin-D2005

OHEP Set: False

DOHS Servers): 212.92.1404

Gatewayis): 192 1621001

Status: Plugged in

o * There were no BElacklisted Devices wulnerabilities detected

Screenshot 99 — Sample report showing devices

o Host machine IP and name

o List showing USB devices detected for each host machine

o List showing blacklisted USB devices detected for each host machine

o List showing network cards detected for each host machine

o List showing blacklisted wireless devices detected for each host machine

Use this report to:

e List information on devices detected on the network including host
information and whether the devices are blacklisted.

Shares

Scan reference: 192,165.100,2-192,165.100, 2%
Scan date & time: Z29-Now-Z006 10:12

Operating System Service Pack

Mind ows 2P Gold
Narme Remark
9 * ADMING Remote Admin
C¥ Defaultshare
IFCE Remote IPC

Screenshot 100 — Sample report showing shares
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o Host machine IP and name

o Share folder details for each host machine, including name and remarks

Use this report to:
e List information on shared folders for each host machine.

Open ports

Scan reference: 192,168,100,2-192, 165,100,254
Scan date & time: 11/29/2006 10:11:19AM

o » 05 - LUCIANF

Operating Systern Service Pack
Windawe =P 2

e * 21[ FTF == File Transfer Frotocol]

25[ SMTP==Simple Mail transfer Frotocol]
1235 [epmap== DCE endpoint resolution

1329 [Metbiosssn =+ NETBIOS Session Senice]
443 [HitpS== Secure HTTF]

445 [ Microsoft-Ds]

1,433 [ Microsoft SQOL senver]

Screenshot 101 — Sample report showing open ports

o Host machine IP and name

o Open port details for each host machine, including port number and name

Use this report to:

e List open ports detected for each host on the network including
port number and name.

Installed applications

Scan reference: 192,168,100,2-192, 165,100,254
Scan date & time:  29-Mov-2006 10:12

o 100,114 - ¥SORIN-D 2005
* Operating System Service Pack

Wind ows P Gold

n=talled Applications

2L g

plication Ham Fublisher
GFlLAMguard S.E.L.M.5 GF| Sofhware Ltd. 5.00
Mlicrosoft WET Framewwod 2.0 tlicrosoft Corporation
Microsoft Internet Explorerd SP1
MEXMLA.0 SP2 Parser and S0K hicrosoft Corparation 42098180
Hotepad+
Total Commander{Remowe or Repaii
Whimare Taok Whiuare, Inc. 2.1.0000
Mindows Installer 2.0 (KB22S01E) hicrosoft Corparation 2.0

Screenshot 102 — Sample report showing installed applications

o Host machine IP and name

o Installed application details for each host machine, including name,
publisher and version

Use this report to:

e List installed applications detected for each network host scanned,
including publisher and version details.
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Policies

Scan reference: 192,168,100,2-192.165,100, 254
Scan date & time: 29-Now-2006 10:12

(1
(2 2

Operating Swstem Service Pack
Windows XP 2

0 chars 42 days, 22 hours, 47 nodelay newer foree no histone
minutes, 31secands

ecurity Audit Policy

(3 )

Audit account lagon events True True
Audit account management True True
Audit directory senice access True True
Audit logan ewents False False
Auditobject acces False False
Audit poliey change True True
Audit privilege use True True
Audit processtracking True True
Auditsystem ewvents True True

Screenshot 103 — Sample report showing policies

o Host machine IP and name

o Password policy details for each host machine, including minimum
password length and password history

o List showing security audit policy details for each host machine

Use this report to:

e List password and security audit policy settings for each network
host scanned.

Registry information

Scan reference: 192,165,100.2-192, 165,100,254
Scan date & time: Z9-MNov-Z006 10:12

01

Operating System Service Pack
Windows P Gold

R y
~hiHz : 2082
e * CurrentBuildNumber : 2500
CurrentType : UniprocessorFree
CurrentWersion 1 5.1
Default: 0409
Driverbresc: Creative AudioP CI(ES137 1, ES13730 00D
Driverbresc : Whiware SWGA ||
Identifier: =26 Family 15 Model 3 Stepping 2
InstallLanguage : 0408
FPathHame : CAMIMDOWS
Productld : 5527 4-338-0279231-=22184
Froductiame : dicrosoft Windows =P
RegisteradOrganization : £
RegisteradOwner : i
Softmare Type : SSTEM
SourceP ath : DAENGLISHWIINAPWF ROYZES
SystemRaot : CMVIND OWS
“Wendorldentifier: Genuinelnbel

Run fdzmqlntCert: regswr32 f= maqrt.dil

Run “Whiveare Tools C:Program Fileshhuwareihdiarne
Toolswhdveare Tray.esxe

Run Whiware User Process: CAProgram Fileshlveareihdvearne

T ool MreareUseraxe

Screenshot 104 — Sample report showing registry information
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Host machine IP and name

2]

List of registry entry details for each host machine

Use this report to:

List system related registry information for each network host
scanned.
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Results comparison

Network security log by date

o Compare Scans from Dates: 11/28/2006 342:33PM and 11)25/2006 3:43:10PM
Scan reference: file:list.txt
ocan profile:

(2

Anew patech needsto be installed:
e * Anew patch needsto be installed:
Aonew pateh needsto be installed:
Aonewpateh needsto be installed:
Anew patech needsto be installed:
Anew patech neadsto be installed:
Aonew pateh needsto be installed:
Aonewpateh needsto be installed:
Aonewpateh needsto be installed:
Anew patech neadsto be installed:
Anew patch neadsto be installed:
Aonew pateh needsto be installed:
Aonewpateh needsto be installed:
Anew patech needsto be installed:
Anew patch needsto be installed:
Aonew pateh needsto be installed:
Aonewpateh needsto be installed:
Anew patech needsto be installed:
Anew patech neadsto be installed:
Aonew pateh needsto be installed:
Aonewpateh needsto be installed:
Aonewpateh needsto be installed:
Anew patech neadsto be installed:
Aonew pateh needsto be installed:
Aonewpateh needsto be installed:

Huotfizpatch hasbeen installed: Security Update forifindowms hedia Player S (KBE11555)

Default

Security Update foriind mus XP (KBSE00EE
Security Update foriind aus XP (KBESE9591)
Security Update forifindows X P (BOOOT25)
Security Update forWindows XP (B201017)
Security Update foriindmus XP (KBRO01215
Security Update foritind aus XP (KBQOZ2900
Security Update foruifindows 2P (KB0H0G)
Security Update foriindows 2P (BI0SHR
Security Update forWindows XP (B0S579E0
Security Update foritind aus XP (KBQOZ51E0
Security Update forutind o XP (KBOOSE31)
Security Update forifindows X P (B 11250
Security Update forWindows XP (B9 11250
Security Update forWindmus XP (KB 115520
Security Update foriindaus XP (KBS 1197
Security Update forifindows XP (B3 129150
Security Update forWindows XP (B9 12550
Security Update foriind mus XP (KBS
Security Update foritind aus XP (KBS 422850
Security Update forifindows 2P (KB 171550
Security Update foriindows XP (BI172390
Security Update forWindows XP (B9 17253
Security Update foritind aus XP (KBS129250

SOL Server2000 Service Padid for atabaze Component

Windows b alicious Software Remowval Tool - Juby 2006 (B2
Hotfizpatch hasbeen installed: MDAC 2.8 Service Paddo1.

Huotfizipatch hasbeen installed: Security Update farind ows 2P (KBS0 1900
Hoffizfpatch hasbeen installed: Windows %P Service Padi2.

Screenshot 105 — Sample report showing network security log by date

o Network security scans to be compared

o Host machine on which the comparison was made

List of differences found between comparisons for each host machine.
o Differences are grouped by category, including backdoors, missing
hotfixes, password policy, USB devices and applications

Use this report to:

e Compare results of consecutive scans that have a common profile
and target, grouped by scan date.
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Network security log by host

r-..

Compare Scans from Dates @ 1172872006 2:42:33PM and 11/22/2006  3:42: 10PM
Scan reference:  fileilist.txt
e * Scan profile : Drafault

Mew TCP partisopen: 9583,
Mew TCP portisapen: 9594,
Mew TCP portisopen: 9595,
Mew TCP partisopen: 31770,

Mew UDP portis open: 123,
Mew UDP portis open: 123,
MewmUDP portis open: 137.
Mew UDP portis open: 137,
Mew UDP portis open: 1358,
Hew UDP portis open: 138,
Mew UDP portis open: 4456,
Mew UDP portis open: 4456,
Hew UDP portis open: 500,
Mewm UDP port isopen: 1032,
Mew UDP part isopen: 1033,
New UDP part isopen: 1900,
Hew UDP port is open: 1900,
Hew UDP port is open: 1943,
Hew UDP part isopen: 2431,
Hewm UDP part izsopen: 2527,
Mew UDP part is open: 4500,
Mew UDP part is open: 8595,

il Cards

The wirtual device "Whivware Vitual Ethernet Adapter forWhinets' (hiAC: 005056 COO00= was added.
The virtual device "Whivware Wirual Ethernet Adapter forWVhinet?' (WAC: 005056 CO0001was added.
Thewvirtual device 'Packet SchedularMiniport (MAC: 'O0:0E0C20AZ 2 was addad.

The physical wired device "Seneric Manmrell vukon Chipset based igabit Ethermnet Confrollei b AC:
'O0:0E:0OC 3 CA8 3 was added

Thewvirtual device 'Packet SchedulerMiniport (MAC: 'O0:0E0C30AZ 3 was added.

The physical wired device 'Intel(RIPROM000 M T Netwok Connection' (WAC: '00:0E:0C 3 C:AS 350 imas added.
Thevirtual device 'Packet Scheduler Miniport (AC: 20:FF 20052 : 4153 was added.

The virtual dewice "WAN Minipor(IPY (MAC: "Jruas added.

The wirtual device 'Direct Parallel' (AC: " Twas added.

The wirtual device "WAN Minipot(PPPOEY (MAC: '33:50:6F 4520200 was addad.

Thewirtual dewice "tAM Minipo (PP TPY (MAC: 'S0:50:54:50: 2020 was added.

Thewirtual dewice "W0AM Minipod (L2 TR (MAC: was 3dded.

The zoftmare enumerated device 'RAS AsyncAdapter (WMAC: "ivwas added.

Screenshot 106 — Sample report showing network security log by host

o Host machine on which the comparison was made

o Network security scans which were compared

List of differences found between comparisons for each host machine.
o Differences are grouped by category, including backdoors, missing
hotfixes, password policy, USB devices and applications

Use this report to:

e Compare results of consecutive scans that have a common profile
and target, grouped by host machine.
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Baseline changes comparison

The computer used as Comparison Standard

Scan Date: 11/28/2006 3:47:54FM
Scan reference: file:list.bxt
o * Scan Profile : Default

Operating System: Windows Server 2003
Service Pack:

Comparing Standard Computer with hosts from scan session

e * Scan date & time: 11/25/2006 3:42:33FM
Scan reference:  file:lisk. bxt

Scan profile: Default

R

Operating System Service Pack
Windowes 2P 2

General Host

Atleastone ofthe two scanswas not completed .

Hostname hasbeen changed: CB; before mas: MAR K.

MAC hasbeen changed:00-02-44-54-0E-DB; before was: 00-0E-0C-23C- 422G,
LAN managerhasbeen changed: ; before was: Windomus 2000 LAN hianager.
Anotherdomainisbeing used none: ; before was: WORKEGEROUP.
Computerusage hasbeen changed:Member Senvar; before was: Wodstation.
Anotherservice padhhasbeen installed: ; before was: 2.

Screenshot 107 — Sample report showing security settings comparison

o Details of the computer used as comparison standard, including scan
date, and scan profile

o List showing host machines with which the standard computer was
compared

List of differences found when comparing the host machines with the
o standard computer. Differences are grouped by category, including

backdoors, missing hotfixes, password policy, USB devices and
applications

Use this report to:

e Compare results between a choused computer, used as
benchmark, and host machines scanned with the same profile and
having the same target.
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Troubleshooting

Introduction

The troubleshooting chapter explains how you should go about
resolving issues you have. The main sources of information available
to users are:

¢ The manual — most issues can be solved by reading the manual.
o The GFI Knowledge Base — accessible from the GFI website.
o The GFI technical support site.

e Contacting the GFI technical support team by email at
support@agfi.com.

e Contacting the GFI technical support team using our live support
service at http://support.gfi.com/livesupport.asp.

e Contacting our technical support team by telephone.

Knowledge Base

GFI maintains a Knowledge Base, which includes answers to the most
common problems. If you have a problem, please consult the
Knowledge Base first. The Knowledge Base always has the most up-
to-date listing of support questions and patches.

The Knowledge Base can be found on http://kbase.gfi.com/.

Request technical support via email

If, after using the Knowledge Base and this manual, you have any
problems that you cannot solve, you can contact the GFI technical
support team. The best way to do this is via email, since you can
include vital information as an attachment that will enable us to solve
the issues you have more quickly.

The Troubleshooter, included in the program group, automatically
generates a series of files needed for GFI to give you technical
support. The files would include the configuration settings, debugging
log files and so on. To generate these files, start the troubleshooter
wizard and follow the instructions in the application.

In addition to collecting all the information, you will be asked a number
of questions. Please take your time to answer these questions
accurately. Without the proper information, it will not be possible to
diagnose your problem.

Then click the troubleshooter\support folder, located under the main
program directory, compress the files in ZIP format, and send the
generated ZIP file to support@gfi.com.
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Ensure that you have registered your product on our website first, at
http://customers.gfi.com.

We will answer your query within 24 hours or less, depending on your
time zone.

Request technical support via web chat

You may also request technical support via ‘LiveSupport (web chat)’.
You can contact the GFI technical support department using our
LiveSupport service at http://support.gfi.com/livesupport.asp.

Ensure that you have registered your product on our website first, at:
http://customers.gfi.com.

Request technical support via phone

You can also contact GFI by phone for technical support. Please
check our website for the correct numbers to call, depending on where
you are located, and for our opening times.

Technical support website:
http://support.gfi.com.

Ensure that you have registered your product on our website first, at
http://customers.gfi.com.

Web Forum

User to user technical support is available via the web forum. The
forum can be found at:

http://forums.qgfi.com/.

Build notifications

We strongly suggest that you subscribe to our build notifications list.
This way, you will be immediately notified about new product builds.
To subscribe to our build notifications, go to:

http://support.gfi.com.
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